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The Artlantis Family
Artlantis combines the most advanced and effective functions for realistically simulating the material and lighting
effects needed for any 3 dimensional project. Artlantis Render communicates directly with leading CAD architecture
software (such as ArchiCAD, VectorWorks, SketchUp, AutoCAD, Arc+, etc.) and can import the main CAD file
formats formats: DXF, DWG, 3DS, DWF, OBJ, FBX SKP, GS1. As well as OBJ, DWF, FBX, SKP, U3D expert
functions.
Artlantis technology is available in two main versions, offering a product line suited to different needs and practices.

Artlantis Render - Radiosity for fixed images
Artlantis Render is a unique and ideal tool for performing very high resolution rendering easily and in real time. The
FastRadiosity™ engine lets you calculate radiosity images... with preview in real time. Artlantis Render uses 3D components and 3D vegetation directly in the preview window by simply dragging and dropping them. This enables
users to work quickly on the various scenarios and simulate virtual scenes in a real environment.

Artlantis Studio - Animation for everyone
Artlantis Studio is the perfect tool for professionals who design presentations based on fixed images, animation,
QuickTime VR panoramas, etc.
Equipped with the new FastRadiosity™ engine, Artlantis Studio offers advanced functions such as scene animation
and object animation, to name just a few. Just like with most Artlantis functions, camera pan, viewpoints and aim
points are defined easily and intuitively.

Artlantis Media
In addition to the standard library, Abvent offers theme-oriented CD-ROMs that provide a multitude of materials and
3D objects that you can use to produce composite images. These are produced specially for Artlantis by a number of
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industry partners or independent designers.
This icon indicates functions that are particular to the Artlantis Studio version.

New Features in Artlantis 3.0
New radiosity rendering engine
l
l

l

Improvement in the light model which shows a fine level of detail. See " Example: light model" page 3
Access to predefined interior and exterior light settings. See "Display of rendering options for the "realistic
photo" engine in the current mode" page 161
Working in Expert mode allows the user to find the best lighting performance. See " Viewpoint rendering settings in Expert mode in the "Photorealistic" engine" page 162

New geometry management
l

l

l

Geometry is handled by Hierarchy See " The Objects Inspector by Hierarchy" page 124 or by Layer. See "
The Objects Inspector by Layer" page 126
When an object is saved, this can be done externally (.aof) or internally (linked to the current project). See "Creating the object" page 133
Billboards and 3D vegetation have a transparency factor. See "Transparency:" page 135

New graphic repositioning of an object's anchor point
l

Internal or external (.aof) object anchor points can be instantly redefined from the 2D view. See " Working with
Objects in 2D View" page 39

New light falloff
9. 9 predefined lighting projections.

New Feature: animated water
l

Water can be animated directly from the Shader Inspector. There is no longer any need to adjust their settings
in animation mode.See "Animation settings:" page 111See "Animation settings:" page 111

New Feature: cloud animation
l

Clouds can be animated directly from the heliodon Inspector. There is no longer any need to adjust their settings in animation mode. See "Wind " page 147

New management of Medias when a project is opened
l

Missing media can be: searched, replaced or deleted. See " Opening an Artlantis File" page 15

New Feature: exporting a project in another format
l

U3D, DWF, OBJ, FBX, SKP. See " 3 - Saving a Document" page 1

Import upgrade
l
l

DWG, DXF and DWF compatible with the AutoDesk 2010 range. See " 2 - Opening Documents" page 1
For ArchiCAD 13 users, Artlantis 3 now retrieves all the defined levels. See " 2 - Opening Documents" page 1
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- Opening old Artlantis files

Example: light model

Artlantis Studio 2 ambient lighting.

Artlantis Studio 3 ambient lighting.

Opening old Artlantis files
Opening Artlantis 2 files
By default, the files will keep the same appearance as in version 2. The Radiosity rendering settings will be under
Custom in the drop-down menu. According to the type of view you can redefine an interior or exterior lighting type.
You can also define other custom settings - see Expert settings.

Opening Artlantis 1.2 files
Scenes produced in Artlantis 1.2 must be converted.
Shaders Inspector
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Texture Definition Controller
In Artlantis 3, the software's engine automatically computes the level of texture definition.

Modifying the Material Definition
In earlier versions of Artlantis (including version 1.2), material definition was based on an "Extended Phong"
model that was perfectly suited to rendering for launching rays, but was not appropriate for radiosity. Artlantis 3.0
interprets material components more realistically. The definition of Shaders is not changed by compatibility concerns
with the Shader collection acquired.
Viewpoints Inspector
The old Atmosphere function is no longer supported and more advanced functionalities are available in the Heliodons inspector (simulation of sky and sun, natural fog, cloud editor).
The 2-color gradation has been replace with a new 3-color gradation.
Gradation rotation is no longer supported.
Depth of field effects are slightly different.
The hatch engine is no longer available and has been replaced by the Post-Production Effects.
Heliodon Inspector
The radiosity contribution check box has been removed. The sun and sky contribute to overall illumination.
5 colors have been deleted for customizing the sky. Artlantis 3 uses a new sky and sun simulation with natural
lighting. When files produced in 1.2 are opened, they are converted to this new physical simulation model.
Light inspector
Artlantis 3 uses a physical light model that is not compatible with the version 1.2 light settings.
The radiosity contribution check box has been removed. The light contributes to overall illumination.
The parallel light has been removed.
The spot and lighting point are merged under lights.
The blurred shadow and transition parameters have been removed and replaced by a variable that is available for all
lights.
Catalog
It is no longer necessary to catalog the media folder.
Simply specify your preferred folder.

System Requirements
Minimum System Requirements
l
l
l
l
l
l
l
l

Mac Intel Dual-Core 2,66 GHz
RAM : 4 Gb.
System: Mac OS X 10.5.7
128 MB graphics card, OpenGL 1.4 capable.
Display resolution: 1024 x 768 million colors
Internet access
QuickTime™7.6.2
3-button mouse with wheel.

Recommended System Configuration
l
l
l
l
l
l
l
l

Mac Intel 8 Core
RAM 6 Gb
System: Mac OS X 10.6
512 MB graphics card, OpenGL capable.
Display resolution: 1600 x 1200 or greater
Internet access
QuickTime™7.6.2
3-button mouse with wheel.
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Serialization
About the Software activation.
In this chapter you will learn about the following subjects:
Activating and Evaluating Artlantis
License Activation for Mac OS X
Creating an Artlantis License Port
Deactivating the License
Evaluation Period
Install and activate network license

5
5
7
9
11
11

Activating and Evaluating Artlantis
The first time Artlantis is launched, the activation and evaluation dialog box appears, as shown below:

Evaluation Period
License Activation for Mac OS X (New License)

License Activation for Mac OS X
By Internet

First:
l

l

Locate the serial number * (composed of two numbers separated by a dash) that is shown on your registration
card or was e-mailed to you.
Check that you are connected to the Internet. Artlantis will have to connect to the activation server.

NB: when launched, Artlantis will check automatically for an Internet connection.
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l
l

Enter the serial number.
Click on the Activate License button. A message will display confirming activation. Close out of the message to
display the open file dialog.

NB: *the serial number can be used regardless of whether you are using a Mac or Windows.

Potential Problem: License Cannot Be Validated

The maximum number of users associated with the license in question has been reached. To activate the license
number of a new workstation, you must first deactivate it on the workstation(s) currently using this license*. You can
then activate the number on the new workstation. Another solution is to purchase a new license at a reduced cost.
Contact your reseller for more information.

NB: * You do not have to uninstall the software.Simply deactivate the license.

Manual
In case of no Internet connection.

l

Locate the serial number (composed of two numbers separated by a dash) that is shown on your registration
card or was e-mailed to you.

l

Jot down the identification number located on the license handler (this number is encrypted).
Use a machine connected to the Internet and go to the Artlantis activation site at: http://activation.artlantis.com

l

l

Once the activation page appears, enter the identification number that you had written down earlier then click on
the button "Connect to server".
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You will then receive a license number that you will copy and paste in the Enter your Activation code field of the
license handler.

NB: You can access the license manager by going to: Artlantis Menu > License...

Creating an Artlantis License Port
Mac OSX 10.5 Step Sequence
l

If Artlantis is not activated and your Firewall settings are on, it will ask you to authorize the connection to the
activation server.

l

If you want to set this Firewall connection manually, select the Security icon on the Preferences System dialog.

l

Select the Firewall Tab.
Click on the + icon to add the application to the services list.

l
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l

Select the Artlantis application icon then click on Add.

Artlantis is added to the list, you can authorize the connections with the popup menu.

Artlantis Keyserver with OS X 10.5
l

At the System prompt, click to authorize the incoming network connections.
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Mac OS X will validate this condition on the Firewall Tab of the Security Services

NB: changing this setting does not affect the security of the Mac or the operation of other software.

Deactivating the License
Artlantis Menu > License… click the Deactivate tab.

To deactivate the license, click on "Deactivate license". Then click Close.

Manual
In case of no Internet connection.
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l

Click on the Deactivate license button then confirm the deactivation.

l

Jot down the identification number located on the license handler (this number is encrypted).
Use a machine connected to the Internet and go to the Artlantis activation site at: http://activation.artlantis.com

l

l

Once the activation page appears, enter the identification number that you had written down earlier then click on
the button "Connect to server".

The server will send you back a code number that you have to copy and paste in the Enter the deactivation code
field in the License Manager.
l

Click on the Close button, then validate to confirm the deactivation.
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Evaluation Period
Clicking on "Evaluate" launches Artlantis in evaluation mode for 30 days. All of the software's commands are operational for this period of time: Open, Save, etc. The only restriction is that the Artlantis demo logo appears at the bottom of renderings.
The application will no longer open files after the 30-day trial period has expired. However, it will continue to start up
so it can be activated. Contact your reseller to purchase a license.

l
l

Click on "Activate License" to access the activation dialog.
Click on "Quit" to close out of the program.

NB: With the licensed version, you can continue any work you started using the evaluation version.

Install and activate network license
Purpose:
Using the Artlantis Keyserver enables you to launch Artlantis on a specific number of client computers connected to
the same network.
At an instant t, Artlantis can be launched on x-number of client workstations simultaneously (with "x" being the
number of licensed workstations). Once it is launched on x-number of workstations, Artlantis will not launch on any
additional workstations without first quitting out of it on one of the stations where it is open.

Requirement:
l
l
l

a single network with Mac and/or PC workstations connected (Important: no sub-network).
A special "Network" serial number.
The Artlantis Keyserver application located in the Artlantis installation directory.

Installation:
Install and validate the license either over the Internet (recommended) or manually.

Step 1 - Activate the network license on the server
l

On a LAN, select the computer that will act as the server*, then launch ArtlantisKeyserver in the Artlantis installation folder.

* The server can be any computer connected to the network. It is best to select a computer that is connected to the
Internet.
l

Click on "Edit License...". The license manager is displayed,
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Validation by Internet:

l

Enter the network number (composed of two numbers separated by a dash) that is shown on your registration
card or was e-mailed to you.Then click on Activate License. A message should confirm that the license has been
activated correctly.

Validating manually:

l

l
l

l

Locate the serial number (composed of two numbers separated by a dash) that is shown on your registration
card or was e-mailed to you.
Jot down the identification number located on the license handler (this number is encrypted).
Use a machine connected to the Internet and go to the Artlantis activation site at: http://activation.artlantis.com
Once the activation page appears, enter the identification number that you had written down earlier then click on
the button "Connect to server".
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You will then receive a license number that you will copy and paste in the Enter your Activation code field of the
license handler.

Start the Artlantis Keyserver * application located in the Artlantis folder that was installed.

NB: Artlantis KeyServer must be launched only on the server workstation. The server identification number
is activated only once on client workstations.
* In order for the client workstations to be able to use Artlantis, the Server must be activated and Artlantis KeyServer launched. They can operate on the Artlantis server and Artlantis Keyserver at the same time.

Step 2: Install Artlantis on the client workstations.
l

l

Make sure that Artlantis Keyserver is launched on the server.You can now launch Artlantis on the client stations.
Click on Check Network to find an available key. If there is an available license on the server, the application
will be activated immediately.

Potential Problems
l

l

l

If Artlantis prompts you for a serial number on a client workstation: Check that the computer is connected to the
local network. Check that the Artlantis Keyserver has been started on the server.
Server workstation, the standard Mac firewall settings pose no problem. If this turns out not to be the case,
manually open UDP from the "Terminal" application by using the command "sudo ipfw add allow
udp from any to any 49150 in". You will be prompted to enter the administrator password. Under
Mac OSX 10.5 you can unblock the port when the System invites you to.
For a Client workstation the Firewall settings have to be changed. Select System preferences > Security >
Firewall and add the Artlantis application to unblock incoming connections. See creating Artlantis License
port images.

NB: changing this setting does not affect the security of the Mac or the operation of other software.
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Opening Documents
Artlantis reads the following document formats:

NB: for ArchiCAD 13 users, when you export to Artlantis, you have the option of exporting the geometry
according to the ArchiCAD layers. In Artlantis' Objects Inspector, the ArchiCAD layers will be listed in the Layers
tab. If you do not want to export the geometry in multiple layers but in a single layer only, check Single layer in the
export dialog box.

NB: ArchiCAD, SketchUp and VectorWorks export** directly to the Artlantis ATL format.
**If you do not have the export plug-in for one of the programs, you can download it at: www.artlantis.com/download/update

In this chapter you will learn about the following subjects:
Opening 3DS Files
Opening an Artlantis File
Opening DWG/DXF Files
Opening DWF Files
Opening OBJ Files
Opening FBX Files
Using reference files

15
15
17
18
18
18
19

Opening 3DS Files

l
l
l

Scale factor : reduces or enlarges object size. The scale factor is a homothetic coefficient.
Converting cameras or lights: Imports lights and/or cameras defined in the original model.
Translation: Redefines the position of the imported object relative to the scene's geometric tag.

NB: Artlantis imports material names, textures and fixed cameras.

Opening an Artlantis File
Either by:

Double clicking on an ATL or AOF file.
When the following dialog appears when the file is opened, this means that one of the Medias associated with the
project is missing. Click on the missing element(s)
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l

l
l
l

Delete: permanently deletes the missing linked Media, it will no longer be requested when the document is
opened.
Folder...: lets you browse through the hard disk to define the folder containing the missing listed elements.
Replace by...: allows the missing Media to be substituted by another.
Continue: closes the dialog box taking account of the options selected.

Opening a File when the Application Launches

Open Recent
l

Lists the last 10 Artlantis documents opened.

Open...
l

Displays the dialog box for opening documents.

Artlantis files saved in a version earlier than 2.0 must be converted when they are opened. When this occurs, Artlantis displays a data conversion dialog:

Convert lamp power:
In version 1.2, lamp powers varied from 0.10 to 5000. From version 2.1, the power varies from 1 to 1000000.
n

Box checked: The lamp power values will be readjusted according to the new 1 to 1000000 scale. If you use the
digital field to set the value beyond that, the power values will not be replaced.
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n

Box unchecked: Lamp power values are retained. Note: the lamps will not have the same intensity.

The neon Shaders are not activated, so they will not take part in the lighting of the scene:
By default, the neon Shaders in version 1 will be deactivated. You can activate them using the viewpoint inspector
drop-down menu.
Replace current background with natural sun and sky:
n
n

Box checked: The sky and sun replace the background defined in version 1.2.
Box unchecked: The version 1.2 background is not changed.

Activate infinite ground:
n

n

Box checked: An infinite ground will be placed at an altitude of 0. The altitude setting will be made in the Object
inspector.
Box unchecked: No infinite ground. However, infinite ground may be activated in the Object inspector.

Quit
l

Closes the program without opening any document.

Drag/Drop a file to the Artlantis icon

NB: Artlantis also reads the old OPT/DB file formats produced by Artlantis 4.0

Opening DWG/DXF Files

l
l
l
l

Scale factor reduces or enlarges object size. The scale factor is a homothetic coefficient.
Curve segmentation value: The number of stops needed to define a curve or a circle entity.
Import closed contour: Considers closed contours the same as surfaces.
Block treatment: Interprets the block's material based on the following:
n Its composition
n Its instantiation
n Its name
n A distinct block has a distinct material.
n Each component of a given block has a distinct material.
n

l

A distinct material is attributed to each bloc name.

Allocating materials: To be defined either depending on the colors or the block layers.

NB: Artlantis recognizes the ACIS 3DSolid entities of AutoCad dwg and dxf files.
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Opening DWF Files

Scale factor reduces or enlarges object size. The scale factor is a homothetic coefficient.
Coordinate system:
n Vertical axis orientation: The height defined in the modeler according to depth axis Y or height axis Z.
n According to handedness: Right or left, viewed from above, changes the object's symmetrical view.

l
l

Use system coordinate and unit parameters: import the file with the standard settings.

l

NB: Artlantis imports material names and textures.

Opening OBJ Files

l

Scale factor reduces or enlarges object size. The scale factor is a homothetic coefficient.

l

Coordinate system:
n Vertical axis orientation: The height defined in the modeler according to depth axis Y or height axis Z.
n According to handedness: Right or left, viewed from above, changes the object's symmetrical view.

NB: Artlantis imports material names and textures*.
*You must also generate an MTL file when importing textures. The OBJ and MTL files must be side by side when
importing.

Opening FBX Files
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l

Scale factor reduces or enlarges object size. The scale factor is a homothetic coefficient.

l

Coordinate system:
n Vertical axis orientation: The height defined in the modeler according to depth axis Y or height axis Z.
n

According to handedness: Right or left, viewed from above, changes the object's symmetrical view.

NB: Artlantis imports material names, textures, light sources and fixed cameras.

Using reference files
File Menu > Use Reference File...

This command lets you:
l

Refer to a previously created .atl file in order to recover Shaders, Lights, Heliodons, Objects, Perspectives,

l

Parallel Views, Panoramas, VR Objects or Animations
as desired.
Update the geometry and materials between the modeling software and Artlantis.

In the dialog box, check the elements to be recovered from the reference file: Shaders, Lights, Heliodons, Objects,
Perspectives, Parallel views, Panoramas, VR Objects, Animations.

Example of Updating Geometry*:
Let us assume that you need to add a door to a document named "A.atl" that is dressed, lighted, etc.

Steps:
1. Save the current A.atl document.
2. Return to the modeler and add the door. Export the file again and rename it B.atl.
3. Open the B.atl file in Artlantis. Select Use Reference File... from the File menu and select the reference file A.atl
in the dialog box.
Artlantis will apply the checked options from file A to file B, i.e. Shaders, Lights, Heliodons, Objects, Perspectives,
Parallel Views.

NB: for files from modelers which export in file formats DWG, DXF, 3DS, FBX, OBJ, DWF, , you must first
save the files in .atl format.

NB: limitations to the Use reference file... command :
1 - if a material has been renamed or reassigned, it will not be included
2- if a part of the geometry has been saved as an object, the destroyed geometry will reappear
3- if the Artlantis layers containing the geometry of the scene are renamed, the geometry they contain will not be
included.
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NB: * the CAD software ArchiCAD and Vectorworks allow you to directly update an atl file already worked
on in Artlantis. Please refer to the documentation for the software involved.
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Saving a Document
Artlantis saves to the following document formats:
ATL The working document.
AOF Format for scenes, as well as objects.
Archive Contains all elements of a project.
3ds, 3D Studio format.
DWF, the vector graphics file format for AutoCAD 2D and 3D.
OBJ, Wavefront file format.
Universal 3D, (U3D) the standardized file format for the universal exchange of 3D files.
SKP, SketchUp file format.
In this chapter you will learn about the following subjects:
Saving an ATL Document
Saving an AOF Document
Saving a U3D Document
Saving an FBX Document
Saving a DWF Document
Saving an OBJ Document
Saving an SKP Document
Saving an Archive

21
21
22
22
23
23
23
23

Saving an ATL Document
Saves the current Artlantis document to your file system. If you try to close an unsaved document, or you go to quit
out of Artlantis when an unsaved document is open, Artlantis will warn you to save your work before continuing.
File > Save

NB: Saved documents will no longer be compatible with earlier versions.

Saving an AOF Document
Saves the entire active scene as an .aof object. Does not replace or close the file you are currently working on.

NB: The origin of the created object is similar to the Scene origin, to modify See "Transfer the origin of the
anchor point:" page 130
l

Select File > Export as Object...
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1. Include light group:
l

Choose the light group you wish to save with the object. This group will be automatically integrated
into the project concerned.

2. Object positioning:
l
l

Always vertical to project regardless of the surface to which it is applied (for example, a vehicle).
Perpendicular to the surface on which it is placed.

Saving a U3D Document
Saves the whole active scene in Universal 3D (U3D) format. Does not replace or close the file you are currently
working on.
l

Select File > Export...> U3D.

Saving an FBX Document
Saves the whole active scene in fbx format. Does not replace or close the file you are currently working on.
l

Select File > Export...> fbx.
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Saving a DWF Document
Saves the whole active scene in DWF format. Does not replace or close the file you are currently working on.
l

Select File > Export...> DWF.

Saving an OBJ Document
Saves the whole active scene in OBJ format. Does not replace or close the file you are currently working on.
l

Select File > Export...> OBJ.

Saving an SKP Document
Saves the whole active scene in SketchUp format. Does not replace or close the file you are currently working on.
l

Select File > Export...> SketchUp.

Saving an Archive
Saves the current document in the folder that groups all of the elements pertaining to the active document: *.atl files
and media folders: Shaders, Objects and Images and an ArchiveReport.txt file. This is a useful function for users to
share their projects.
File > Export as Archive...
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Artlantis Interface
General Information
By default, the Artlantis menu bar, the inspector navigation palette and the Preview window appear when the program is started up.
The following other elements can be called up: General Preferences, the 2D View window, the Media Catalog, the
Timeline and the Batch Rendering window.
Place the cursor over the palettes and window commands to display pop-up help bullets.
You can drag/drop objects, Shaders, textures, background images from the catalog or directly from the hard drive
to the Preview window.
Placement of Artlantis Palettes and Windows
1.
2.
3.
4.
5.
6.
7.
8.

Menu bar
Inspector palette
Toolbar
2D View Window
Catalog
Timeline
Preview
Viewpoints List

In this chapter you will learn about the following subjects:
Navigation inspector
The Artlantis Menus
Artlantis Menu
File Menu
Edit Menu
Display Menu
Inspector Menu
Window Menu
Tools Menu

26
27
27
28
29
29
31
31
32
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Help Menu
The 2D View Window
Editing in 2D View

32
32
33

Fixed Images
Animations
2D View Display and Navigation Tools
Customizing the 2D View Toolbar
Modifications in 2D View
Editing the Clipping Box
In 2D View
Preview Representation
The Preview Window
Preview display and navigation tools
Customizing the Preview Toolbar
The Timeline Window
Introduction:
Display
Animating
The Timeline window is divided into the following 4 areas:
Keyframes and Guides
Keyframes
Guides:

33
33
33
34
34
75
75
75
76
77
78
78
78
78
78
79
83
83
86

Navigation inspector
Enables the user to edit viewpoints and animations, to configure model dressing, apply lighting effects and integrate
the project into its environment.
The behavior of certain mouse and keyboard shortcuts is dependent on the current Inspector.
The Inspector is a floating palette which can be repositioned at will.

The following 9 inspectors are available:
Shaders
Lights
Heliodons
Objects
Perspectives
Parallel Views
Panoramas
VR Objects
Animations

Activation and changing from one Inspector to another: either using the Inspector menu, or via the navigation bar at
the top of the Inspector palette.
l

Click on the desired Inspector (e.g. Heliodon in the figure below).
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l

To navigate between viewpoint and animation inspectors right-click the current icon.

The Artlantis Menus
Use the menu bar to access the following commands: file management, display, navigation among the various edit
modes, managing window opening and closing, and online help.
In this chapter you will learn about the following subjects:
Artlantis Menu
File Menu
Edit Menu
Display Menu
Inspector Menu
Window Menu
Tools Menu
Help Menu

27
28
29
29
31
31
32
32

Artlantis Menu
About Artlantis
Information on the Artlantis version being used.

Preferences...
Defines the program's overall behavior.
Keyboard Shortcut: Cmd ,

License
Displays the License activation manager.

Services
Provides access to Mac OS X system services.

Hide Artlantis
Hides Artlantis allowing the user to work in a different program. To return to Artlantis, click on the Artlantis icon in
the dock.
Keyboard Shortcut: Cmd H

Hide Others
Hides all visible applications except for Artlantis. To go to a different application, click on the application's icon in the
dock.

Display All
Displays all Mac OS X programs that are active.

Quit Artlantis
Quits Artlantis after saving (or not saving) the open document.
Keyboard Shortcut: Cmd Q
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File Menu
Contains the commands for managing documents (opening, saving, printing).

Open...
Saved Artlantis *.atl document. This command will directly open files in the following formats: atl, aof, opt/db, dwg,
dxf, dwf, obj, fbx, skp and 3ds.

NB: Artlantis recognizes the ACIS 3DSolid entities of AutoCad dwg and dxf files.
Keyboard Shortcut: Cmd O

Open Recent File
Fast access to a list of recently used files. You can clear the list by using "Clear Menu".

Merge Geometry from File...
A file currently opened can be merged with another file: atl, aof, opt/db, dwg, dxf, dwf, obj, fbx, skp and 3ds.

Close
Closes the document if the Preview window is active.
Closes the active window: The 2D Window, Media Catalog.
Keyboard Shortcut: Cmd W
Save
Saves the current Artlantis document to your file system. If you try to close an unsaved document, or you go to quit
out of Artlantis when an unsaved document is open, Artlantis will warn you to save your work before continuing.

NB: Saved documents will no longer be compatible with earlier versions.
Keyboard Shortcut: Cmd S

Save As...
Opens the Save As dialog box, pointing to the current folder. You can save the current file as a new document. (Enables the user to rename the file and save it to a different folder). The new file becomes the active document.
Keyboard Shortcut: Shift Cmd S

Reverts to the saved version
Active document when it was last saved.
Export as Object...
Saves the entire active scene as a "*.aof" object. Does not replace or close the file you are currently working on.
Export as Archive...
Saves a current document to the folder containing all elements belonging to the active document: *.atl files and media
folders: Shaders, Objects and Images and an ArchiveReport.txt file. This is a useful function for users to share their
projects.
Export…
Exports the geometry of the current document in 3ds, OBJ, SKU, U3D or DWF format.

Use a reference file...
Imports complete elements or parts of elements from a different atl. file into the current file. Shaders, lights, heliodons, objects, Perspective cameras, Parallel Views, VR Objects and Animations can be imported.

Page setup...
Accesses Mac OS X page lay-out controls: Used for selecting and configuring the printer and options for the pages
to be printed. For more information, see Mac OS X help.
Keyboard Shortcut: Shift Cmd P
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Print...
Sends the contents of the active document's Preview window to the selected printer. For more information, see Mac
OS X help.

NB: The Preview window is printed in "draft" mode. This is a check and not a quality printout.
Keyboard Shortcut: Cmd P

Edit Menu
Contains the following standard commands for managing the file: Undo/Redo/Cut/Copy/Paste/Erase/Special Characters.

Undo
Undoes the last command. Also allows the user to step backwards undoing all operations performed since the document was opened. The number of operations that can be recovered is limited only by the amount of memory available. The command's heading shows what action is undone and applies to the active window. Redo is the opposite
operation of Undo.
Keyboard Shortcut: Cmd Z

Redo
Reverses the last Undo command and displays the action to be redone in the heading.
Keyboard Shortcut: Maj Cmd Z

Cut
This command works in numeric fields, inspector lists.The cut element is stored in the clipboard. Clipboard contents
are retained until the next Cut/Copy operation is performed.
Keyboard Shortcut: Cmd X

Copy
This command works in digital fields and inspector lists.The element copied is stored in the clipboard. Clipboard contents are retained until the next Cut/Copy operation is performed.
Keyboard Shortcut: Cmd C

Paste
Pastes the contents of the clipboard into inspector lists and numeric fields. Clipboard contents are retained until the
next Cut/Copy operation is performed.
Keyboard Shortcut: Cmd V

Delete
Removes the selected elements from inspector lists, numeric fields, and objects in the scene.
Keyboard Shortcut: Del

Select All
Selects all elements in Light and Object inspector lists.
Keyboard Shortcut: Cmd A

Special Characters
Opens the Mac OS X character palette so the user can insert special characters (mathematical symbols, accented
letters, arrows, etc.). For more information, see Mac OS X help.

Display Menu
Contains commands for displaying the project in the active view (Preview Window, 2D View window).
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Enlarge/Reduce
l

In the Preview window:
Factor of 1.5x from center.Sizes are to be defined in the Artlantis Preferences. Maximum size 1200x1200,
minimum size 640x640.

l

In the 2D View window:
Factor of 1.5x from center.

Keyboard Shortcut: Enlarge Cmd + and Reduce Cmd -

Fit in Window
l

l

In the Preview window:
Fit the view to the window size.
In the 2D View window:
Instantly displays all elements of a project.

Keyboard Shortcut: Cmd =

Zoom
Acts the same way in the Preview and 2D View windows except that, in Preview, the camera target and the focus are
recomputed.
l
l

Zoom + click in the window enlarges the view 2x from the point clicked.
Zoom + click, followed by dragging and dropping into the window enlarges it in relation to the center of the
rectangle.

To zoom out, depress the Alt key before clicking or describing the limiting box. The tool deactivates when the command is finished.
Keyboard shortcut: Zoom in Cmd * Zoom out Cmd * then alt

Pan
Moves the content by dragging and dropping in the desired window. The tool deactivates when the command is finished. The camera target is recalculated for the Preview window.
Keyboard Shortcut: Cmd /
Holding down the middle button on the mouse produces the same effect.

Change 2D View
Replaces the current projected view with a different one: Top, front, right, left or rear.
Keyboard Shortcut: 1, 2, 3, 4 or 5

2D View Display
Enables the user to change the type of display: Wireframe or Textured mode.

Previous
In 2D view, this enables the user to navigate by back-stepping upwards through the sequence of views displayed in
the tree structure.
Keyboard Shortcut: Cmd <

Next
In 2D View, this enables the user to navigate downwards through the sequence of views displayed in the tree structure.
Keyboard Shortcut: Cmd >

Hide Toolbar
Displays/hides the bar for the view active in Preview or 2D View.

Customize Toolbar...
The view activated in Preview or 2D View dictates whether this function is active or not. You can customize the toolbar to meet your needs and the way you work.
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Inspector Menu
Contains the inspectors for views (perspectives, parallel views, panoramas, VR Objects, animations), lighting effects
(lights and heliodons), scene dressing (shaders, textures, objects), and environment (sun, sky, background and foreground images, insertion to site, depth of field, fog, pollution, ambient, post-production effects).

NB: It is not always necessary to change the edit inspector in order to modify a project. There are sufficient
commands available, regardless of which inspector is active.

Perspectives
Displays the Perspectives inspector.

Parallel Views
Displays the Parallel View inspector.

Panoramas
Displays the Panoramas inspector.

VR Objects
Displays the VR Object inspector.

Animations
Displays the Animations inspector

Shaders
Displays the Shader inspector.

Lights
Displays the Lights inspector.

Heliodons
Displays the Heliodon inspector.

Objects
Displays the Object inspector.
Render
Displays the rendering window for defining the rendering format and options, as well as the destination.
Keyboard Shortcut: Cmd R
Partial Render
In the Preview window, draw a rectangle by dragging across two opposite corners to define the area you wish to
render. The rendering appears in a new window. The Save Image dialog box appears when you close the rendering.
Keyboard Shortcut: Cmd Shift R

Batch Rendering...
The Batch Rendering window handles the state, destination and format of batch renders that have been defined in
advance using the Render command.

Window Menu
Contain the window activation commands: 2D View, Catalog

2D View
Displays the projected view: Top, front, right, left or rear.

Catalog
Displays the Media Catalog.

Timeline
Displays the Timeline.
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Scene information:
Displays the scene settings dialog .

Minimize
Reduces the size of the window for the current document to a minimum and places it in the Dock. For more information, see Mac OS X help.
Keyboard Shortcut: Cmd M

Bring everything to the foreground
Brings all open Artlantis windows to the foreground (document, windows, etc.). For more information, see Mac OS
X help.

Tools Menu
Create Shader
Opens the Edit Shader dialog

Create a Postcard™
Saves the current view as a Postcard™

Help Menu
Artlantis Help
Online Artlantis documentation containing reference information on each of the program's functions, plus detailed
illustrated tutorials.
Keyboard Shortcut: Cmd ?

Artlantis web site
Opens your Web browser to the Artlantis Home page by default: The English language Artlantis forum, product
information, updates, FAQs, training, etc.

Additional Media
Displays additional media available on the Artlantis Web site

Tutorials Online
Displays the tutorials page in your Browser.

On-line registration...
Lets you register the product directly on the Abvent site. Fill out the form displayed then confirm.

The 2D View Window
This is used for viewing and editing the project in the following 5 projected views: Top, front, right, left or rear.
View display is independent of the current inspector. Example: In the Perspectives inspector, you can edit lights in
2D View without activating the Lights inspector.
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2D View display and navigation tools
Customizing the 2D View Toolbar
Keyboard and Mouse Shortcuts

Editing in 2D View
Right clicking on the element you wish to edit displays a pop-up menu for the current operations: Duplicate, Delete,
Attribute To, etc. These are performed in real time in the Preview window and in the relevant inspectors.

Fixed Images
Working with Objects in 2D View
Working with Parallel Views in 2D View
Working with Perspectives in 2D View
Working with Lights in 2D View
Modifying Heliodons
Working with the Clipping Box in 2D View

Animations
Working with Panoramas in 2D View
Working with VR Objects in 2D View
Working with Panoramas in 2D View

2D View Display and Navigation Tools

Default tools available
Previous and Next: Used for moving between displays.
Fit in Window: Maximizes the display of all of the geometry and lights to the full size of the window.
Zoom: Increases the zone defined by a rectangle. Alt+Zoom reduces the display.
Pan : Reframes the content of the window.
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Change View: A drop-down menu for selecting the projected view.
Edit Path: In animation mode, is used for creating or modifying a path relative to a camera, a light or an
object

Customizing the 2D View Toolbar
The following tools are available by right clicking on the toolbar:

To add a tool, drag and drop it onto the bar. To delete a tool, drag it outside of the bar.
Display mode: Switches from wireframe to textured display.

Modifications in 2D View
In this chapter you will learn about the following subjects:
Working with Perspectives in 2D View
Working with Parallel Views in 2D View
Working with Objects in 2D View
Working with Lights in 2D View
Modifying Heliodons
Working with the Clipping Box in 2D View
Working with VR Objects in 2D View
Working with Panoramas in 2D View
Working with Camera Animation in 2D View
Working with Light Animation in 2D View
Working with Object Animations in 2D View
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39
41
45
47
48
52
54
61
68
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Working with Perspectives in 2D View
Display Wireframe Mode

State or Action
Viewpoint inactive

Active viewpoint selected.

Comments
Represented by the camera (gray point).

Represented by the camera
(red point), the target (gray
point), the focusing angle
(blue lines) and the angle's
bisector line (gray line).

l

Move the camera.

l

Move the red point.

l

Move the target.

l

Move the gray point.

l

Move the camera in a
parallel direction.

l

Move the gray bisecting line.

l

Change the focusing
angle.

l

Move one of the 2
blue lines.

l

Duplicate viewpoint

l

Press ALT and move
the camera (red
point).

l

Right click on the
camera then select
"Duplicate" in the
pop-up menu.

or

or
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l

Delete viewpoint

l

Right click on the
camera then select
"Delete" in the popup menu.

l

Edit an active light
with this viewpoint.

l

Right click on the
camera (red point).In
the pop-up menu,
choose "Edit Light",
select the name of
the light.

NB: The inspector palette switches from Perspectives mode to Lights
mode.
l

Edit an Active Heliodon with this Viewpoint.

l

Right click on the
camera (red point)
then select "Edit Heliodon" in the pop-up
menu.

NB: The inspector palette switches from Perspectives mode to Heliodons
mode.
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Working with Parallel Views in 2D View
Display Wireframe Mode

State or Action

Comments

Viewpoint inactive

Represented by the camera
(gray point).

Active viewpoint selected.

Represented by the camera
(red point), the target (gray
point), the width of view
(red lines) and the symmetry
axis linking the camera and
the target (gray line).

l

Move the camera.

l

Move the red point.

l

Move the target.

l

Move the gray point.

l

Move the camera in a
parallel direction.

l

Move the gray symmetry axis.

l

Define the view area.

l

Move one of the red
lines.

l

Duplicate the viewpoint

l

Press the ALT key
then move the camera (red point), tar-

or
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get (gray) or the
symmetry axis
(gray).
or

l

Delete viewpoint

l

Add to Viewpoints
List: Perspectives, Panoramas, VR Objects or
Sequences

l

Edit an Active Heliodon with this Viewpoint.

l

Right click on the
camera then select
"Duplicate" in the
pop-up menu.

l

Right click on the
camera then select
"Delete" in the popup menu.

Right click on the camera
then select "Add To List..."
in the pop-up menu.

l

Right click on the
camera (red point)
then select "Edit
Heliodon" in the
pop-up menu.

NB: The inspector
palette switches from the
Parallel View mode to Heliodons mode.
l

Edit an active light
with this viewpoint.

l

Right click on the
camera (red
point).In the pop-up
menu, choose "Edit
Light", select the
name of the light.

NB: The inspector
palette switches from Parallel View mode to Lights
mode.
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Working with Objects in 2D View
Display Wireframe Mode

State or Action

Comments

Object deselected

Represented by the geometry
and a green center point.

Selected object

Represented by the geometry
and a blue center point.

l

Move an object.

l

Move the blue point if
the object is active or
green point if it is inactive.

l

Duplicate an Object.

l

Press Alt and move blue
or green point.

l

Multiple duplication of
an object

1. Press Shift+Alt keys and
draw out a (green) line.
2. Hit the "plus" key to
indicate the number of
copies (pink points).
Press the "minus" key to
remove them.
3. Validate by hitting
Enter.

1

2

3
Make Multiple Duplicates of
More than One Object.

1

l
l

Select the objects:
Cmd+click the objects

1. Press Shift+Alt keys and
draw out a (green) line.
2. Hit the "plus" key to
indicate the number of
copies (pink points).
Press the "minus" key to
remove them.
3. Validate by hitting
Enter.

2
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3
Use as camera target/Do not
use as camera target for an
animation or perspective
view

Redefine the anchor point of
an object

l

Select the object, press
D then in 2D View drag
the object's blue anchor
point.

This works for internal or
external object).

NB: Object deletion is done from the inspector list.
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Working with Lights in 2D View
Display Wireframe Mode

State or Action

Comments

Deselected light is off

Represented in shaded yellow.

Selected light is off

Represented in shaded yellow circled in black.

Deselected light is on

Represented in bright yellow with
thin black circle.

Selected light is on

Represented in dark orange with
thick black circle.

Move a light

Move the yellow point(s) depending on the type of light.

l

l

Turn On/Off

Turn current light light on/off

NB : Selecting more than
one light enables you to turn them
on/off at the same time.

l

Duplicate a light.

l

Hit the Alt key to move the
yellow point.

l

Right click on the yellow
point and select "Duplicate"
in the pop-up menu.

or

NB: The duplicated light
retains the parameters of the reference light (power, shadows, etc.).
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l

Multiple duplication
of a light

1. Press Shift+Alt keys and
draw out a (green) line.
2. Hit the "plus" key to indicate the number of copies
(pink points). Press the
"minus" key to remove
them.
3. Validate by hitting Enter

l

Make multiple duplications of more than
one light

l

1

2

3
Select lights belonging to
the same group:
Cmd+click the lights.
1. Press Shift+ALT keys and
draw out a (green) line.
2. Hit the "plus" key to indicate the number of copies
(pink points). Press the
"minus" key to remove them
3. Validate by hitting Enter

1
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retain the parameters of the reference light (power, shadows, etc.).
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2

3
l

Cut a light

Deletes the current light, but
holds it in memory so it can later
be pasted into a light group from
the lights list. (To paste into the
lights list, right click on the name
of a group and select Paste)

l

Copy a light

Copy the current light without
deleting it. It is held in memory
so it can later be pasted into a
light group on the lights list. (To
paste into the lights list, right
click on the name of a group and
select Paste)

NB: Selecting more than
one light enables you to copy
them at the same time.
l

Delete a light

l

Right click on the light then
select "Delete" in the popup menu. The light is
deleted. To recover the
light, go to Edit > Undo
Delete Lights
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l

Edit a view using this
light.

l

Right-click the light. In the
pop-up menu, choose "Edit
View Using This Light".
Select the name of the
view.

NB: The inspector palette
switches from the Lights mode to
Viewpoints mode (Perspectives or
Parallel Views).

Page - 44

Artlantis Interface - The 2D View Window

Modifying Heliodons
Sun Position

Position the
sun based on
the
geographical
location, date
and place

Display Wireframe Mode

State or Action

Orientation
l

Setting the orientation
of North

l

Pivot the yellow point
around the compass.
The yellow arrow
will move accordingly around the circle.

Comments

True North (compass
point).
The rays of the sun
(yellow lines with
arrow points) are
positioned depending
on the location, true
North and the date
and time.

NB: Use the
Heliodons inspector
to configure these elements, except for true
North.
Shadows are then
recomputed in the
Preview window.
Manually
move the
sun.

l

Manually positioning
the sun.

Shadows are then
recomputed in the
Preview window.
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Limit the
sun
to
alwayscasting shadows at 45°
depending
on viewpoint position.
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l

Graphically moving
the viewpoint redirects shadows cast to
45°.

Shadows are then
recomputed in the
Preview window.
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Working with the Clipping Box in 2D View
Wireframe Display Mode

State or Action
Limiting box

Comments
Represented by a blue crosshair and rectangle.

l

Click/drag inside
the box to move
it.

l

Resize Clipping
Box

Move the blue points located
at the corners.

l

Turn Clipping
Box

Turn the blue handle of the
crosshair around its center.

Move the center of the crosshair to redefine the axis of
rotation

Elevated view

Editing operations on the
same as on plane except that
the box does not pivot.
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Working with VR Objects in 2D View
Wireframe View on Plane Mode Display
Hemispherical
Toric

Wireframe
View in
Elevation
Mode Display
mode

State or Action

Comments

VR object deselected

Represented grayed by the
target and a circle.

VR object
selected.

Top view: represented by
the camera (gray dot on
the circle), the target (central red dot).

Spherical

The camera moves around
the blue circle. The focus
opening angle is defined by
the two blue lines and the
angle bisector (gray line).

In Elevation: The target
point is red. 2 gray points
linked by a shaded line represent the camera altitude.
The small red points on the
circle represent the camera movement pitch (pitch
value dissociated in top
and elevated views).
l

Move VR
objects.

Top view:
l

Move the target in
red, or the bisector
in gray.

In Elevation:
l

or
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Move the target in
red or the shaded
horizontal line.
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l

Move the
camera.

Top view:
l

Move the gray point
in the blue circle.

In Elevation:
l

Adjust the camera
height by moving
the shaded horizontal line that
runs through the
two gray points.

NB: In these views,
the camera position defines
the starting image when the
VR objects are read.

N/A

N/A

l

Change the
focusing
angle.

Angle Opening
Constraint

l

Indicates the starting position of the angle opening
relative to 0° in a trigonometric circle.

l
l

Lock position of VR
object starting angle.

Move one of the 2
blue lines.

Pivot the blue
radius around the
red point in the
center. This
changes the constraint value in the
VR Object/Coordinates inspector.
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N/A

l

Limit VR
Object Opening Angle
Horizontally.

Enter an angle value of
<360° in the VR Object/Coordinates inspector.

Once open, the circle can
be edited graphically.

The opening angle value
depends on the Constraint
angle value.

Same
as
plane view
+

or
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l

Duplicate
VR
Object.

l

Press ALT and
move the camera
target in red..

l

Right click on the
camera then select
"Duplicate" in the
pop-up menu.

or
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Same as plane
view

l

Delete VR
Object.

l

Right click on the
camera then select
"Duplicate" in the
pop-up menu.

Same as plane
view

l

Edit Light
active with
this VR
Object.

l

Right click the red
target. In the pop-up
menu, select "Edit
Light", select the
name of the light.

NB: The inspector palette switches from VR Object
mode to Lights mode.
Same as plane
view

l

Edit active
Heliodon
with this VR
Object.

l

Right click on the target in red and select
"Edit Heliodon" in
the pop-up menu.

NB: The inspector palette switches from VR Object
mode to Heliodons mode.
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Working with Panoramas in 2D View
Wireframe Display Mode

State or Action
Panorama
lected

Comments

dese-

Indicated by the camera (gray
dot) and the horizontal or vertical
viewpoint
movement
circle.Viewpoint active.

Panorama selected

Represented by the camera (red
point), with the target (blue) moving in a circle (blue circle), the
focus angle (blue lines) and the
angle's bisector line (red line).

l

Move the
panorama.

l

Use the red point for this.

l

Move the
target.

l

Move the blue point in the
blue circle.

NB: The target point position defines the starting image
when the panorama is read.

Page - 52

Artlantis Interface - The 2D View Window

l

Move the
panorama in
a parallel
direction.

l

Move the red bisecting
line.

l

Change the
focusing
angle.

l

Move one of the 2 blue
lines.

l

Duplicate
the viewpoint

l

Press ALT and move the
camera (red point).

l

Right click on the camera
then select "Duplicate" in
the pop-up menu.

+

or

or

l

Delete viewpoint

l

Right click on the camera
then select "Delete" in the
pop-up menu.
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l

Edit Light
active with
this viewpoint.

l

Right click on the camera
(red point). In the pop-up
menu, choose "Edit Light",
select the name of the light.

NB: The inspector palette
switches from the Panorama mode
to Light mode.

l

Edit active
Heliodon with
this viewpoint.

l

Right click on the camera
(red point) then select "Edit
Heliodon" in the pop-up
menu.

NB: The inspector palette
switches from Panorama mode to
Heliodons mode.

Working with Camera Animation in 2D View
2D View Window
Path edits are clearly distinguished from keyframe edits.
This concerns the paths for cameras, lights, and objects as well as the relevant pop-up menus.

Editing Paths

Camera path is in red.

NB: Camera target points can be edited graphically at any time, regardless of whether record mode is on or
not.
Use the Edit Path
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tool in the window bar to select the mode.
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l

Button pressed:

Path editor is active (As a result, editing the keyframe in the view is inactive).

l

Button raised:

Keyframe editor is active (As a result, the path is visible but cannot be edited).

Create Path
l
l

In
mode, move the camera viewpoint.
This draws a red path in a straight line.
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l
l

White dots circled in gray indicate start and end points that have tangents.
The tangent handles are indicated by red dots circled in black.

Move Path
l

Click on the path and move it.

Modifying the Path
l

Use the handles to graphically edit the tangents.

Add a Control Point
l

Right-clicking the red path line and selecting "Add Control Point" displays a gray circle and a tangent with two
editing handles.
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To edit a portion of the tangent at a point
l

Right click on the point and select "Unlock Tangent" to create an inflection point on the path.

To delete the inflection point
l

Right click on the point and select "Lock Tangent".
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Extend Path
Extends the path without touching the existing animation.
l

Alt+Click on the last control point created for the path.
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l

Creates a new control at the end of the path.

NB: The timeline can be used to play the sequence at any time.
Path Edit Pop-up Menu
l

Right clicking on the red path displays a pop-up menu with the following options:

l
l
l
l
l

Add Control Point: adds an editable point to the path.
Delete Control Point: deletes the point from the path (except the end points).
Close Path: closes the path on itself.
Open Path: re-opens the path.
Delete Path: deletes the path.

Editing Keyframes

Camera path is in red.

NB 1: You must be in record mode in order to edit in the Timeline.
Keyframe Edit Pop-up Menu:
l
l

Add Keyframe: adds a keyframe.
Delete Keyframe: deletes a keyframe

Add a keyframe
l

l

In

mode, button is raised (not active).

In the Timeline window, click on record
the pop-up menu.

in 2D view, right click the path, select "Add key frame" from
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This creates the keyframe.

The keyframe can be moved graphically on the path, making it possible to speed up, slow down, etc.

NB: A keyframe selected in 2D View appears with a red pin on the Timeline. A pause can be created in the
movement of the element by duplicating a keyframe in the Timeline.

NB 2: When editing or reading a sequence, the Preview window displays the content in OpenGL Navigation mode if "Automatic Switch to OpenGL" has been checked in the preferences.

The 2D View Edit Filters Pop-up Menu:
This displays and/or hides paths in order to improve editing in 2D View.
l

Right clicking on the white background of the 2D window displays the following pop-up menu that makes it
easier to edit in 2D View, as well as display and hide paths.

l

Display All: displays all camera, light and object paths.
Show only current type elements: Depending on which inspector is active (Animations, Lights or Objects), displays all camera, light or object paths.
Display Only Current Element: displays only the path currently being edited.

l

l
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Viewpoint Edit Pop-up Menu:
Regardless of whether the user is in path or time edit mode, right clicking on a camera's target or one of the blue lines
that represent the focus opening will display a pop-up menu with the following options:

l

l
l
l
l

Duplicate: duplicates the sequence, the current camera position becomes the default view, the path is not duplicated. Uses the original to create a new superimposed viewpoint.
Add to Perspectives View List:
Add to Parallel Views list
Add to Panorama list
Add to VRObject List

Depending on option selected, adds current view from Perspectives to Parallel Views, Panoramas, or VR Objects.
l

l

l

Edit Light Activated With This Viewpoint :
Choose a light. The inspector palette switches to Lights mode and the light is selected.
Edit Heliodon Activated With This Viewpoint:
The inspector palette switches to Heliodons mode and the heliodon is selected.
Delete: The viewpoint is removed from the list.

Working with Light Animation in 2D View
2D View Window:
Path edits are clearly distinguished from keyframe edits.
This concerns the paths for cameras, lights, and objects as well as the relevant pop-up menus.

Editing Paths

The light path is in yellow.

Use the Edit Path

tool in the window bar to select the mode.
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Button pressed:

Button raised:
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Path editor is active (As a result, editing the keyframe in the view is inactive).

Keyframe editor is active (As a result, the path is visible but cannot be edited).
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Create Path

l
l
l
l

In
mode, move the light source.
This draws a yellow path in a straight line.
White dots circled in gray indicate start and end points that have tangents.
The tangent handles are indicated by red dots circled in black.

Move Path
l

Click on the path and move it.

Modifying the Path
l

Use the handles to graphically edit the tangents.
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Add a Control Point

l

Right clicking the yellow path line and selecting "Add Control Point" displays a gray circle and a tangent with
two editing handles.

Result.

To edit a portion of the tangent at a point:
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l

Right click on the point or on an "Unlock Tangent" item handle to create an inflection point in the path.

Result.

To delete the inflection point

l

Select "Lock Tangent".

Result.

Extend Path
Extends the path without touching the existing animation.
l

Alt+Click on the last control point created for the path.
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NB: The timeline can be used to play the sequence at any time.
Path Edit Pop-up Menu
l

Right clicking on the yellow path displays a pop-up menu with the following options:

l

l

Add Control Point: adds an editable point to the path.
Delete Control Point: deletes the point from the path (except the end points).
Close Path: closes the path on itself.
Open Path: re-opens the path.

l

Delete Path: deletes the path.

l

Right clicking on a control point or tangent handle displays a pop-up menu with the following options:

l
l
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n
n

Lock Tangent: to delete an inflection point.
Unlock Tangent: to create an inflection point. This makes it possible to create an inflection point to
manipulate sections of the tangents independently.

Editing Keyframes

NB 1: You must be in record mode in order to edit in the Timeline.
Keyframe Edit Pop-up Menu:
l
l

Add Keyframe: adds a keyframe.
Delete Keyframe: deletes a keyframe.

Adding a key image
l

In

l

In the Timeline window, click on record
from the pop-up menu.

mode, button is raised (not active).
in 2D view, right click the path, select "Add key frame"

This creates the keyframe.

The keyframe can be moved graphically on the path, making it possible to speed up, slow down, etc.

NB: A keyframe selected in 2D View appears with a red pin on the Timeline. A pause can be created in the
movement of the element by duplicating a keyframe in the Timeline.

NB 2: When editing or reading a sequence, the Preview window displays the content in OpenGL Navigation mode if "Automatic Switch to OpenGL" has been checked in the preferences.

Keyframe Edit Pop-up Menu:
This displays and/or hides paths in order to improve editing in 2D View.
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l

Right clicking on the white background of the 2D window displays the following pop-up menu that makes it
easier to edit in 2D View, as well as display and hide paths.

l

Display All: displays all camera, light and object paths.
Show only current type elements: Depending on which inspector is active (Animations, Lights or Objects), displays all camera, light or object paths.
Display Only Current Element: displays only the path currently being edited.

l

l

Working with Object Animations in 2D View
2D View Window
Path edits are clearly distinguished from keyframe edits.
This concerns the paths for cameras, lights, and objects as well as the relevant pop-up menus.

Editing Paths

Object path is in green.

l

Use the Edit Path

l

Button pressed:

l

Button raised:
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tool in the window bar to select the mode.
Path editor is active (As a result, editing the keyframe in the view is inactive).
Keyframe editor is active (As a result, the path is visible but cannot be edited).
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Create Path

In

mode, move the object.
l
l

White dots circled in gray indicate start and end points that have tangents.
The tangent handles are indicated by red dots circled in black.

This draws a green path in a straight line.
Move Path
l

Click on the path and move it.
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Modifying the Path

l

Use the handles to graphically edit the tangents.

Add a Control Point

l

Right-clicking the green path line and selecting "Add Control Point" displays a gray circle and a tangent with
two editing handles.

Result.
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To edit a portion of the tangent at a point:

l

Right click on the point or on an "Unlock Tangent" item handle to create an inflection point in the path.

Result.

To delete the inflection point:

l

Select "Lock Tangent".
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Result.

Extend Path
Extends the path without touching the existing animation.

l

Alt+Click on the last control point created for the path.

Result.

NB: The timeline can be used to play the sequence at any time.
Path Edit Pop-up Menu
l

Right clicking on the green path displays a pop-up menu with the following options:
n Add Control Point: adds an editable point to the path.
n Delete Control Point: deletes the point from the path (except the end points).
n Close Path: closes the path on itself.
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n
n

l

Open Path: re-opens the path.
Delete Path: deletes the path.

Right clicking on a tangent handle or control point displays a pop-up menu with the following options:
n Lock Tangent: to delete an inflection point.

or
n Unlock Tangent: to create an inflection point.
After unlocking the tangent, you can create an inflection point to work independently with half tangents.

Editing Keyframes

Object path is in green.

NB 1: You must be in record mode in order to edit in the Timeline.
Keyframe Edit Pop-up Menu:
Right clicking on the green path displays a pop-up menu with the following options:
n
n

Add Keyframe: adds a keyframe.
Delete Keyframe: deletes a keyframe.
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Add a keyframe

l
l

In

mode, button is raised (not active).

In the Timeline window, click on record
the pop-up menu.

in 2D view, right click the path, select "Add key frame" from

This creates the keyframe.

The keyframe can be moved graphically on the path, making it possible to speed up, slow down, etc.

NB: A keyframe selected in 2D View appears with a red pin on the Timeline. A pause can be created in the
movement of the element by duplicating a keyframe in the Timeline.

NB 2: When editing or reading a sequence, the Preview window displays the content in OpenGL Navigation mode if "Automatic Switch to OpenGL" has been checked in the preferences.

The 2D View Edit Filters Pop-up Menu:
l

Right clicking on the white background of the 2D window displays the following pop-up menu that makes it
easier to edit in 2D View, as well as display and hide paths.

l

Display All: displays all camera, light and object paths.
Show only current type elements: Depending on which inspector is active (Animations, Lights or Objects), displays all camera, light or object paths.
Display Only Current Element: displays only the path currently being edited.

l

l
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Editing the Clipping Box
This is a blue box with corner handles that can be edited.

l

l

Activation and display in Viewpoint inspectors: Perspectives, Parallel Views, Panoramas, VR objets,
Animations.
Entering an angle value in degrees in the numeric field pivots the box within the plane.

In 2D View
Change the view (above, front, right, left, rear) to define more than one clipping plane in the space (up to a maximum
of 6 clipping planes).

l

Edit the blue handles to define the clipping planes.

Elements outside the blue box are cut out of the scene.
When viewing from above, the rotation angle can also be defined graphically in 2D View.

NB: When elements are clipped, the shadows projected are adapted.

Preview Representation
Example of a clipping box in Perspective view.
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Inactive Clipping Box

Active Clipping Box

The Preview Window
The main working window. It displays the final render in real time before any calculation is initiated!

Both the toolbar commands (Navigation, Zoom, Pan, Front View) and the Keyboard and Mouse Shortcuts specific to
the Preview window are used to navigate within a scene.
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Preview display and navigation tools
Customizing the Preview Toolbar
Redimensioning the size of the Preview Window
l

Move the lower right corner. The size of the displayed content is not affected (Preview preferences, or keyboard and mouse shortcuts).

Preview display and navigation tools

Activates and deactivates display in OpenGL mode. Useful for navigating within large databases.

NB: Shadows and lighting effects in OpenGL depend on the Preference settings.

Back: Resets the camera to the position defined when the view was activated.
Zoom: Moves the camera (the zone in question is defined by a rectangle). The Alt+Zoom option moves the camera backwards.
Pan: Pans the scene by moving the active camera.
Pan To: Positions the camera perpendicular to the surface clicked.
Update: Saves the viewpoint position (viewpoint, target, focus distance and camera roll). This tool only works
when the Automatic Update option is not activated in the General Preferences.
Displays the 2D View window.
Catalog: provides access to Catalogs and Media (Shaders, Objects, Images and Postcards).
Refine Preview: Radiosity display becomes close to end result.
Render: Opens the dialog box for preparing and launching rendering.
Partial Render: Within the scene, this initiates rendering of the zone bounded by the rectangle.
Create Postcard: saves current viewpoint as a Postcard.
Current layer: destination of an object when dragging and dropping an object in
the scene.
l

If Auto is checked:
Drag-drop an object in the scene, this object will go into the layer appropriate to its type or into the active
layer if there is no default destination layer for this object type.

l

If Auto is unchecked:
The popup menu for the layer shows the destination layer for an object during a drag-drop in the scene as
long as there is no default destination layer for this object type.
Navigation in viewpoints.
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Customizing the Toolbar

SpaceNavigator Peripheral Compatibility:
l

Ergonomics: hardware compatibility with SpaceNavigator from 3D Connexion, a 3D navigation tool.
Lets you navigate through the scene and edit items in the scene using the mouse.

Customizing the Preview Toolbar
l

Right clicking on the bar displays the following:

To add a tool, drag and drop it onto the bar. To delete a tool, drag it outside of the bar.

Access toolbar customization settings.

The Timeline Window
Introduction:
Animation work is done using the Animations, Lights, Heliodons or Objects and the 2D View, Preview window
and the Timeline window.
The timeline enables the user to record, edit and play a scene. The scene is made up of sequences that are managed in
the Animations Inspector list.

Display
Activating the Animations inspector displays the Timeline window.
If the Timeline window closes again, click on the Animations inspector icon or go to Windows > Timeline.

Animating
Artlantis animates practically all commands relating to the inspectors:
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l
l
l
l
l

Cameras (animations)
Lights
Heliodons
Objects
Animated Textures

Begin as follows to animate the parameters for cameras, lights, heliodons, objects and animated textures:
1. Activate the Animations inspector, then
2. Activate the Light, Heliodons, Object or Shaders inspector

Comment: The Timeline window will remain open to enable you to edit animation times.

NB: In 2D View, the Timeline and the appropriate inspector must remain open in order to create
and edit animated paths for lights, objects or cameras.

The Timeline window is divided into the following 4 areas:

1. Title Bar: Shows the name of the current sequence.
2. Time scale : Gives duration of the scene with a slide bar and cursor for positioning and editing keys and
sequences.
3. Recorder : Controls recording and playback of animations.
4. Sequence Length Control: Used for editing the duration and rate of images.
Title Bar

Name of the current sequence, as defined in the animations list. The timeline updates relative to
the current sequence (blue band). The other sequences in the scene (gray bands).
Time scale

The slide bar is the time scale that shows the total time in the scene. The time runs from left to
right.
The cursor shows the current scene time at instant T.
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NB: The current position also displays in 2D View, if the element is animated on a path.
Click and drag to move the cursor. The cursor is blue. When a keyframe passes, it sticks to the
pin and becomes red.
The cursor moves away from it when:
• The time is edited
• The current sequence is played.
• The mouse wheel can be used to zoom on the scene when rolling over the time scale.

Time scale zoom cursor:
just a portion of it.

Enables the user to show the entire scene or focus on

Current sequence: The sequence is delimited by its start
l

l

and end

pins.

The start, end or duration of the sequence can be modified by clicking and dragging the pins
to change them individually.
The entire sequence can be moved without changing the duration by clicking and dragging it
on the blue line.

A tooltip with a yellow background indicates
the current position in min: sec: on the Timeline.

NB: The keyframes and guides do not follow the movement. Subsequently, the
numeric Time and Duration fields are updated.
The top of the time scale indicates the events that relate to an animated element.
The bottom of the time scale shows the events relating to one of the values for the animated element in question.
Selecting keys of an animated element.

l

Right clicking above the slide bar: displays the keys of an animated element, and selects
one of the elements.
Consequences:
n
All animated keys corresponding to the element in question display on the slide bar.
n
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The inspector corresponding to the element becomes the current inspector enabling
the user to edit its parameters rapidly.
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NB: The user can also access the animated element by clicking on the triangle
located in the upper right-hand section of the window (above the slide bar).

Selecting keys of the current animated element.

l

Right clicking below the slide bar: Displays the animated settings for the current element.
The sub-keys matching the setting appear below the slide bar.
Result:
All sub-keys corresponding to the parameter for the element in question appear on the slide
bar.

NB: The user can also access the animated parameter by clicking on the triangle
located in the lower right-hand section of the window (below the slide bar).

NB: In order to select the parameter for an animated element, you must first
select the element and then select the parameter.
Recorder

l

l

This enables the user to navigate in time through the scene, and to play or stop playback of
the sequence. The cursor moves as a result.
Description of buttons from left to right:
n
go to start of sequence
n
go to previous image
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n
n
n
n

play or stop sequence
go to next image
go to end of sequence
Record animations: starts

or stops

the recording.

NB: Sequence playback can be started or stopped by pressing the space
bar.
Sequence Duration Control

Current time of the scene:
indicates the cursor's current position in
the time scale. Expressed in: minutes: seconds: image number. Entering a value
updates the position of the cursor. Dragging the cursor updates the scene time
again.
Duration of the current sequence :
indicates the duration of
the sequence between the start and end pins. Expressed in: minutes: seconds: image
number. Entering a value updates the position of the end pin. Dragging the pins
updates the sequence duration.
Current sequence image:
displays the number of the current image. Entering a value positions the cursor on the time line.
FPS: (frames per second), rate at which images are played per second
Entering a value updates the number of frames played.

.

Loop: Indicates that the sequence will be repeated
. Type in a value to specify the number of loops. The loop will be applied only to the current parameter of
the current animated element.

Keyframes:
appear as colored guides distributed throughout
the time scale.
A pin represents a particular animation event at an instant T. A camera, light, heliodon or object element for which one of the position, rotation, scale, etc. parameters has been modified.
Animation is interpreted between two keys.

Guides:
l

l
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serve as visual markers for synchronizing animated parameters.

Animations : Makes a sequence or edit of animated elements the current
one, whereupon the appropriate inspector displays.
Shortcut: Right click above the time scale.

Artlantis Interface - Keyframes and Guides

l

Modification indicator: Shows the type of animation attached to the current
element (position, rotation, lighting power, atmosphere, etc.). Updates depending on which item is selected in the Animations pop-up.
Shortcut: Right click below the time scale.

Keyframes and Guides
Keyframes
A keyframe indicates a particular event at an instant T in the scene. Keyframes are linked to the following animated
elements: camera, light, heliodon, object, animated textures.

Current animated elements at an instant T: Camera, light; heliodon, object, animated texture.
Animated setting for current element:
Camera: position, rotation, focal, etc.
Light: position, state, type, power, color, etc.
Heliodon: date, time, etc.
Object: position, rotation, scale, etc.
Animated texture: plays the avi or mov sequence.
Animation is interpreted between two keys.

How Keys are Represented

General Information:
l
l

Upper pin indicates a key relative to the current animated element.
Lower pin indicates that an animated setting of the element is current.
Pin

Description
An animated element with edit setting activated (in key). Keyframe not selected (gray).
An animated element with edit setting deactivated (no sub- key). Keyframe not selected (gray).

An animated element with edit setting(s) activated. Keyframe selected (red).

An animated element with edit setting deactivated (no sub- key). Keyframe selected (red).

An animated element. Synchronized editing of animated settings for the element in question. Represents
overlap of at least 2 keyframes.
More than one synchronized animated element. Move the yellow pin and the superimposed keys follow.
Keyframes selected (red).
n

Moving the cursor over a synchronized key (yellow pin) displays the name of the current element,
the position in time and the parameters associated with the element.

More than one synchronized animated element. Move the yellow triangle and the superimposed keys follow.
Non-selected keyframes.
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n

Moving the cursor over a synchronized key (yellow pin) displays the name of the current element,
the position in time and the parameters associated with the element.

More than one animated elements are synchronized. The elements are not standard. Moving the yellow pin
with the arrow moves all superimposed keyframes. Non-selected keyframes.
n
n

Moving cursor over synchronized keys: Displays the information concerning them
Moving the cursor over a synchronized key (yellow pin) displays the name of the current element,
the position in time and the parameters associated with the element.

Selecting keys of an animated element.

l
l

Right clicking above the slide bar: Enables you to select an animated element.
Consequences:
n All animated keys corresponding to the element in question display on the slide bar.
n The inspector in question becomes the current inspector enabling the user to edit its parameters rapidly.

NB: The user can also access the animated element by clicking on the triangle located in the upper
right-hand section of the window (above the slide bar).

Selecting keys of the current animated element.

l

Right clicking below the slide bar: Displays the animated settings for the current element.The sub-keys matching the setting appear below the slide bar.

l

Consequences:
n All sub-keys corresponding to the parameter for the element in question appear on the slide bar.
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NB: The user can also access the animated parameter by clicking on the triangle located in the
lower right-hand section of the window (below the slide bar).

NB: In order to select the parameter for an animated element, you must first select the element and
then select the parameter.

Creating keys
3 options:
1. Upon creating a trajectory in 2D View: two keys are created in the Timeline window - one at the start and
one at the end of the sequence.
2. With record mode turned on in Timeline, right click on the path for the "Add Keyframe" pop-up menu (valid
only for one path).
3. In the Timeline window with record mode turned on, modify a parameter of the current element.

NB: When an element is no longer animated, turning on record mode will create 2 key images. The
one located at the start of the sequence assumes the parameter value before the modification.The second
one located in current time assumes the post-modification parameter value.
If the parameter of an element already has keyframes, the record mode creates a single keyframe.This keyframe is located in the current time and has the post-modification parameter value.

NB: Turning on record mode in the Timeline window forces the 2D View to appear when editing keyframes.

Cursor pop-up menu:
Right click on the cursor (blue or red bullet icon).
1. Add Keyframe:
n Position the cursor on the Timeline.
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n

Right click on the cursor to choose Add Keyframe.

Result: The keyframe is added.

2. Delete a Keyframe

n

Right click on the keyframe and choose Delete Keyframe.

Keyboard Shortcuts
1. Move a Keyframe:
n

Click and drag the pin.

2. Duplicate a Keyframe:
n

Alt+Click and drag the pin. (The 2 keyframes have the same value. Hence, they can freeze a parameter
at a given time.)

3. Moving a set of keyframes for an element (either the camera, lights, heliodon or objects):
n

Shift+Click/Dragging the pin results in: all pins to the right of the click moving in a proportional time.

Guides:

These serve as visual Timeline tags
(blue vertical line).
Enables the user to synchronize more than one animated element (e.g.: : moving a camera must match the same instant
T as opening a door) or to synchronize animated settings tied to the same element.
l
l
l

Creating a guide: Double clicking in the Timeline (not on the slide bar) causes a vertical blue line to appear .
Deleting a Guide: Double clicking on the vertical blue line makes it disappear.
Moving a guide : Drag and drop.

NB: Moving the cursor on the slide bar near a blue guide magnetizes the cursor. This makes it easier to synchronize parameters among several animated elements.
1. Add Guide at the cursor
n Position the cursor on the Timeline.
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l

Right click on the cursor and choose the Add Guide item. Double clic in the Timeline near the cursor
will also add the guide for the cursor position.

The guide is created.

2. Deleting a guide at the cursor

l

Right click on the cursor and choose the Add Guide item. You can also double click the guide.
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The Perspectives Inspector
Manages viewpoints defined by a camera, a target and a focal length. Each viewpoint is considered to be an autonomous document with its own parameters which can receive its own environment:
In this chapter you will learn about the following subjects:
The Perspectives List
Foreground Images
Background Images

90
91
92

Viewpoints List: for handling viewpoints displayed on the list.

1. Camera: settings, check elements to activate.
l

Focal Length: by using the cursor or entering a value (Change the camera angle). The units depends on
the preferences settings.

l

Depth of Field: click
then, in the Preview window, click to define the clear point of the scene,
with the rest remaining blurred. The cursor adjusts the blur amount.
Clipping Box: for defining clipping planes.
Show: In 2D View
Activate: Preview Representation

l
l
l

2. Lighting: To handle light schemes linked to the view, select them from the drop-down
menus.
l
l
l

Heliodon: links a heliodon to the view. Selecting "None" deactivates the heliodon.
Light Group: links one or more light groups to the view. Selecting "None" deactivates the light groups.
Neon Shaders: Links one or more Neon Shaders to the view. Selecting "None" deactivates the lighting.

3. Visible layers: check them in the drop-down menu.
4. Environment: handles the background and foreground of the scene.
l
l

Defining a background: Background type: 3D Sky, Gradient, 2D Image, 3D Image, 3D Cubic
Foreground Images

Page - 89

Chapter 6

l

Site insertion tool automatically sets the camera with a background image.
Clicking

opens the dialog.

5. Coordinates:
l

Camera XYZ Position.

l

Target XYZ Position. Clicking on
locks them and clicking on
unlocks them.
l It is possible to limit a camera's target to an object's movement: In object mode, right click on and object
and select "Define As Target" in the drop-down menu. Then, in Perspectives mode select the name of
the object in question in the Target on menu.
l Camera Roll: Pivots camera laterally. Turn the circular cursor or enter a value in degrees in the related
field.
6. Post-production
Applies effects to the current viewpoint: The effects combine with and between the parameters set in
the inspector.
7. Rendering Parameters
l

l

Prepares the document for final rendering.

NB: editing the scene information such as the infinite ground, movement of the origin, redimensioning of
the model and the coordinates may be accessed via the Window menu.

The Perspectives List
opens the viewpoint list. Each is displayed by name and preview thumbnail. To edit, double-click on the name.

adds a viewpoint
deletes it.

List drop-down menu
l

Right-clicking on a view displays the pop-up menu:
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Duplicate: Uses the original to create a new superimposed viewpoint.
Delete: The viewpoint is removed from the list.
Add toParallel Views List:
Add toPanorama list:
Add toVRObject List
Add to the Animation list
Depending on option selected, adds current view from Perspectives to Parallel Views, Panoramas, VR
Objects or Animations.
Edit Heliodon: The palette inspector switches to Heliodon mode and the heliodon is selected.
Edit light: select a light, the inspector palette switches to Lights mode and the light is selected.

Foreground Images
Defining a Foreground

l

a double-click opens the search dialog for image files.

Load foreground image:
l
l

By dragging and dropping into the inspector's Foreground image area.
Using the Foreground image dialog: double click in the image zone.

NB: The foreground image must have an alpha channel (representing the opacity or transparency
of the image); for example, to view the scene through vegetation.
The file formats accepted are Photoshop, TGA, TIFF, PICT.
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Background Images
In the local Viewpoints menu:

or
Background
type

Description
3D Sky:
In the Viewpoints inspector, the current view is associated with a configurable 3D Sky:
day/night, type of clouds, cloud density.
This is assuming that the clouds have been associated with the heliodon.
and the heliodon in question has been associated to the current Viewpoint.

NB: If the viewpoint doesn't have associated heliodon then the sky is white.
Graduated:
3 colors that mix linearly. By default, one top color, one middle color and one bottom color,
with one graduating horizontally towards the other.
2D Image:
adjusts to the size of the Preview while respecting its ratio (width x height). Use this option
to make an insertion in the site. To move the background image, Ctrl-click on the
thumbnail and drag the cursor.
Resetting the image position : double-click right on the thumbnail.
3D Image:
Creating a 3D environment from an image. To move the 3D background, Ctrl- click on the
thumbnail and drag the cursor..
Resetting the image position : double-click right on the thumbnail.

NB: Check the left-right continuity of the image being used.
3D Cubic:
Creates a 3D environment from a .mov file comprised of 6 surfaces of equal size. To move
the 3D background, Ctrl-click on the thumbnail and drag the cursor.e.
Resetting the image position : double-click right on the thumbnail.

NB: Check the left-right continuity of the image being used.

Loading a background image:

l

By dragging and dropping into the inspector's

area

l

By using the background image dialog: double-click in the background image area
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Deleting a background image
l

Click within the background image and then use the DEL key on your keyboard. A dialog will appear asking
you to confirm the deletion.

NB: the file formats that are supported are: Photoshop, TGA, TIFF, PICT, BMP, and JPEG.
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The Parallel Views Inspector
Manages viewpoints defined by a viewpoint, a target and a display width. Each viewpoint is considered to be an autonomous document with its own parameters which can receive its own environment:
In this chapter you will learn about the following subjects:
The Parallel Views List

96

Parallel Views List: for handling parallel views on the list shown.

1. Parallel views:
l
l

l

Type of projection : Click on Elevation, Top, or Axonometry.
Camera Roll: Pivots camera laterally. Turn the circular cursor or enter a value in degrees in the related
field (available only in Top View).
Scene width: defines the width of the selected view (current unit).

NB: value modification depends of the ViewPoint Update Mode settings in Preferences.

l

Clipping Box: for defining clipping planes.
Show: in the 2D View

l

Activate: Preview Representation.

l

2. Lighting: To handle light schemes linked to the view, select them from the drop-down
menus.
l

l

Heliodon: links a heliodon to the view. Selecting "None" deactivates the heliodon.
Light Groups: Links one or more light groups to the view. Selecting "None" deactivates the light
groups.
Neon Shaders: Links one or more Neon Shaders to the view. Selecting "None" deactivates the lighting.

3. Visible layers: check them in the drop-down menu.
4. Environment: handles the background and foreground of the scene.
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l
l

Defining a background: Background type: 3D Sky, Gradient, 2D Image, 3D Image, 3D Cubic
Foreground Images.

5. Coordinates:
Camera XYZ Position.
Target XYZ Position.
6. Post-Production:
l
l

Applies effects to the current viewpoint: The effects combine with and between the parameters set in
the inspector.
7. Parallel View Rendering Parameters:
l

l

Prepares the document for final rendering.

NB: editing the scene information such as the infinite ground, movement of the origin, redimensioning of
the model and the coordinates may be accessed via the Window menu.

The Parallel Views List
opens the viewpoint list. Each is displayed by name and preview thumbnail. To edit, double-click on the name.

l

adds a viewpoint.

l

deletes it.

List drop-down menu
l

Right-clicking on a view displays the pop-up menu:

l
l
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Duplicate: from the original, creates a new superimposed viewpoint.
Delete: The viewpoint is removed from the list.
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l
l
l
l

l

l

Add to Perspectives list
Add to Panoramas List
Add to VRObject List
Add to the Animation list
Depending on option selected, adds current Parallel view to Perspectives, Panoramas, VR Objects or
Animations.
Edit Heliodon Activated With This Parallel View:
The inspector palette switches to Heliodons mode and the heliodon is selected.
Edit Light Activated With This Parallel View:
Choose a light.The inspector palette switches to Lights mode and the light is selected.
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The Media Catalog
A media allows the project to be dressed by dragging and dropping the thumbnail view onto a scene medium (material, object or background from the Preview window).
In this chapter you will learn about the following subjects:
Catalog Manager
Dressing the Scene with Media
Postcards
Using Postcards

100
101
102
103

4 types of Media: Shaders, Objects, Images and Postcards divided into 2 categories.

The Media Catalog window is divided into 3 areas: Favorites, Thumbnails and Preview.

1. Favorites:
n

Lists the catalogs, editing catalogs.

2. Thumbnails:
n

Displays Media thumbnails and adjusts their size.

3. Media Preview
n

drag/drop Media or Postcard elements to the scene.

NB: Additional samples of Media catalogs are available from Artlantis on DVD or free for download from
our site at www.artlantis.com
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Catalog Manager
Favorites area

Navigating Media Types
Used for going from one Media folder to another:
l

Click on the catalog to be displayed in the favorites area. The Catalog structure is the one on the hard drive.

Adding a Catalog
Opens the dialog for locating folders.
l

Selecting the Media folder to be added.

Updating Catalogs

Updates the content of a catalog folder whose content has been changed.
l

Click right in the favorites area and select "Reload Favorites".

Removing a Catalog
l

Deletes the selected catalog from the favorites area.

NB: Deleting a folder does not erase it from the hard drive. It is available only at the first level of the hierarchy folders.
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Filtering Catalog Media Display

l
l

Click on the local menu of the Display button.
Select the desired option so that the media type you have selected will not be displayed.

Modifying the Size of Catalog Thumbnails
l

Change the cursor to display or reduce the size of the thumbnails.

Dressing the Scene with Media
Dragging/Dropping a Media from the Catalog to the Preview Window
In the Media view area, select the desired media and then drag and drop it into the scene over a material, object or
background (for only one image). The element that is ready to receive the Media is highlighted when the cursor rolls
over it.
In this example, we are applying a shader to the wall:
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Result

Postcards
Collecting and Organizing Postcards. Collecting a PostCard is equivalent to taking a snapshot of the contents of the
current scene at any time, storing all parameters assigned to the materials: Colors, Shaders and textures. The idea is to
facilitate recovery of its settings and, if necessary, to be able to quickly send the information it contains to any other
user, or from one project to another.

Saving a PostCard
Saves the current view as a Postcard.
Tools Menu > Create a Postcard, a dialog box enables the user to name and specify the location where it is saved.
l

Clicking on Save stores the Postcard. There is an unlimited number of saves.

NB: Postcards are saved to jpeg format either in a Postcards folder or another folder that you will have to
catalog.

NB: Although the Postcard is in jpeg format, editing it with an image touch-up program will cause it to lose
Shader and texture-specific information and makes it unusable in Artlantis.
From the Favorites area, navigate to a catalog containing Postcards and select the Postcard in the thumbnail area.

Using a Postcard
In the Catalog Preview area, simply drag and drop Postcard elements to an element displayed in the Preview window.

Sending a Postcard
To send Postcards, find the folder on your hard drive where the Postcards are saved.
l

Find the Postcard on the hard drive and transmit it to another computer.To catalog the Postcard, use the Favorites area in the Catalog window.

On a Mac platform, by default Postcards are saved in the Postcards directory in the Media directory placed next to the
application.

Deleting a Postcard
Locate the Postcard saved on the hard drive and delete it.
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Using Postcards
Select the Postcard.Drag and drop the attributes of a material (color, Shader, texture) to the receiving material in the
Preview window .
1. Starting scene

2. Drag and drop

3. Result

NB: Textures associated with a Shader are maintained and go with the assignment.
When a Postcard includes textures associated with a Shader, once it has been dragged and dropped to a material in the
scene, these textures will also be applied.
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The Shaders Inspector
Shaders
The following different types of shader are available: Basic Shader, Expert Shader, Realistic Glazing Shader,
Luminous Glazing Shader, Neon Light Shader, Realistic Water Shader, Texture
Procedural shaders (formerly Artlantis 4.5 Shaders)
Shaders: Procedural, Mirror, Transparent, Marble, Lines

NB: Shaders can be found in the Media Catalog. Different types of Shaders may have different Shader interface palettes.

NB: editing the scene information such as the infinite ground, movement of the origin, redimensioning of
the model and the coordinates may be accessed via the Window menu.

In this chapter you will learn about the following subjects:
Create Shader
Materials List
List Organization
Realistic Water Shader
The Neon Light Shader
The Basic Shader
Expert Shader
Shaders: Procedural, Mirror, Transparent, Marble, Lines
Luminous Glass Shader
Realistic Glass Shader
Editing Textures
Materials List
Texture Mapping
Reafect a Material
The Materials and Textures Pop-up Menus
Material
Texture

105
108
109
110
111
112
113
114
115
116
117
117
117
119
120
120
121

Create Shader
This is done using an existing Shader either:
l

from the active Shaders inspector, menu: Tools > Create Shader from...

l

or by right clicking on the name of a
From...

material and selecting the option Create Shader

The edit dialog opens with the image of the current Shader. If the current Shader is a procedural, the dialog is empty.
The dialog must be populated with images and values. Do this by dragging and dropping where appropriate or double click on the thumbnail to open a dialog to choose an image.
Once stored, the new Shader will appear as a Standard Shader.
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1. Title:
l

Enter the name of the Shader. This name will appear in the top left of the inspector.

2. Preview
This is the thumbnail that appears in the Shader Inspector and in the thumbnail field of the Catalog.
The thumbnail representing the Shader must be a 128 x 128 pixel jpeg file.
The width of the thumbnail gives the size of the image in cms to a scale of 1.

NB: If you do not provide a thumbnail, Artlantis will use the diffuse image resized to 128 x 128 pixels.

3. Diffuse:
The image must be present. This is the visible part of the Shader. Depending on the pattern, we recommend
an image size of 512 x 512 or 1024 x 1024 pixels.

NB: If the image is not square, Artlantis will stretch it to make it square.
The diffuse width gives the the image in cm on a scale of 1.
Depending on the representation, this size may differ from the preview thumbnail. The diffuse image does
not necessarily represent the same image as the thumbnail.

NB: The diffuse image represents 4 times the size of the thumbnail image but its pattern is 3 x 3 the
size of the thumbnail in order to avoid a repeat effect.
The diffuse image is not visible in the Shaders inspector but displays in the Catalog Preview field.

4. Reflection
The image is optional. It is generally in gray scale but may be in color.
Its size in pixels must be the same as the diffuse image. Otherwise, Artlantis will stretch it depending on the
size of the diffuse image.
The purpose of the reflection image is to modify the value of the reflection cursor:
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l
l
l

In black pixels, the slider value is multiplied by 0.
In white pixels, the slider value is multiplied by 1.
In intermediary pixels, the slider value is multiplied by the intermediary value.

It is useful to limit the effects of reflection at certain parts of the diffuse image.

NB: The slider is limited to a minimum and maximum value. For example, entering a value of 0.35
will define a slider that will range from a minimum of 0 to a maximum of 0.35.
You can test the effects of each of the settings in real time in the Preview window.

5. Shininess
The image is optional and should be in gray scale.
Its size in pixels must be the same as the diffuse image. Otherwise, Artlantis will stretch it depending on the
size of the diffuse image.
The Shininess image is used to modify the slider value: Same as Reflection.

6. Bump:
If the Shader has no Bump image, the slider will be available in the Shaders inspector and Artlantis will use
the diffuse image to provide bump. Hence, the bump image will always be available and will use less system
memory.

7. Normal:
The image is optional. The colors use strict rules to define the bump simulation. Generally, it replaces Bump,
but Artlantis can support both.

Important: It is not simple to create a "Normals" image. If the Shader has no Normal image, the
slider will be disabled in the Shaders inspector.

8. Transparency:
The image is optional and should be in grayscale.
It is used to simulate holes and transparencies in the Shader.
l In black pixels, the Shader is opaque.
l In white pixels, the Shader is transparent.

9. Save Shader as:
Opens the save dialog.
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Create Shader and Shader Interface Match:

Some Basic Shader settings are not available in Create Shader: Rotation, Mix Color, Transparency, Projection
Options, and Materials Identifiers have default values.

Materials List
opens/closes the list of Materials.
They are displayed by name. To edit, double-click on a name.

Toolbar:

l
n
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creates a new material based on the material selected.
The material created appears at the end of the Materials List (before the Object Materials). The textures
linked to the duplicated material are also duplicated.
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l

l

Add a texture to the selected material. Select a TGA, JPEG, BMP, PICT, PNG, TIFF, EPIX, Photoshop,
MOV, AVI, or MPG file.
Delete the selected material or the selected texture linked to a material. Activates when the material is not
associated with the geometry.
Shortcut: Hit the Back key.

l

Enables the user to reassign a material.

List Organization

1. Material:
Names of Materials in the scene are listed in alphabetical order and followed by the name of the Shaders.
Click on the Material name to arrange the names of the materials in alphabetical order or reverse alphabetical
order.

2. Infinite Ground Material:
This is the material applied to infinite ground (Scene Information). It appears at the top of the materials list.

3. Scene:
Clicking on the Scene tab opens/closes the listed materials that are specific to the scene or internal
component.

4. Object Name:
Clicking on the Object tab opens/closes the list of Materials with Shaders and Textures linked to the
object in question.

5. Material Name
When the material is assigned, the name is written in black.

6. Shader Name
Follows the material name: in blue.

7. Texture Name
Follows the material or Shader name: in green. You can use drag/drop to re-arrange the order in which textures associated with a material are mapped. Dragging/dropping one texture to another makes it dependent.
This enables you to move them at the same time.

8. Newly created materials not associated with geometry
The name of the material is written in red.
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9. Object Instance Name
The Object Instance is made up of several materials
The user can drag and drop a Shader onto a material in the list.
The Copy /Paste shortcuts can be used within this list.

NB: Limitations - in an ATL reference file, any material that has been renamed or re-assigned will not be
recognized by the "Use Reference File..." command.
Here, we recommend that you go back to your modeler to distinguish the material names and then, if your modeler allows it, update the atl file or use the "Use Reference File" function.

Realistic Water Shader
Materials List: displays the materials of the scene.

1. Color Selector:
Click to select a diffusion color or enter numerical values (1 to 255) in the RGB fields.

2. Saturation:
Use the slider to choose the color saturation level.

3. Transparency
4. Reflection, Shininess
Gives a reflective appearance to the material.
May be used in conjunction with the color from Diffuse, Transparency or both. Drag the slider to make the
material reflect its environment or enter a value in the related field. The reflection intensity is managed using
gray scale values or RGB values from 0 to 255. Click on the selector to choose a color.
Entering a Limit value defines the maximum distance of the reflection.

5. Fresnel Transition
6. Water surface:
Wave size: Drag the cursor to adjust the wave amplitude or enter a value in the related field. The wavelength
value can be from 0 to 500.
Flatness: Drag the wave amplitude cursor or enter a value in the related field.
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7. Animation settings:
Allows the user to automatically adjust the moving water effect which will only be visible in sequence
animation mode. If the box is unchecked, the movements are suspended.
Allows the user to animate the water movement speed. Values from 1 to 3.

8. Material ID Parameters:
Use the slider to choose the smoothness level for the material.

9. Material Characteristics:
The material is visible or invisible.
The material either projects shadows or it does not.
The material either receives shadows or it does not.

10. Shader/Textures Navigator:
For a material, this makes it possible to navigate between related Shader and Textures editors.

NB: effect only in Artlantis Studio in animation mode

The Neon Light Shader
Materials List: displays the materials of the scene.

1. Color Selector:
Click to select a diffusion color or enter numerical values (1 to 255) in the RGB fields.

2. Saturation:
Use the slider to choose the color saturation level.

3. Lighting Power:
Drag the slider to change power or enter a value (from 0.1 to 5000) in the related field. Click to choose a
color from the system color picker.

4. Transparency
5. Neon:
Drag the slider to adjust the neon power or enter a value in the related field. Click on the selector to choose a
color.
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6. Shininess
7. Material ID Parameters:
Use the slider to choose the smoothness level for the material.

8. Material Characteristics:
The material is visible or invisible.
The material either projects shadows or it does not.
The material either receives shadows or it does not.

9. Shader/Textures Navigator:
For a material, this makes it possible to navigate between related Shader and Textures editors.

The Basic Shader
Materials List: displays the materials of the scene.

1. Color Selector:
Click to select a diffusion color or enter numerical values (1 to 255) in the RGB fields.

2. Saturation:
Use the slider to choose the color saturation level.

3. Diffusion Color:
Another way to select a color is to click to choose a color from the system color picker.

4. Reflection, Shininess
Reflection: Drag the slider.When the diode is red, the material reflects its environment or enter a value in the
related field. Click on the diode to cancel the command.
Limit: Entering a Limit value defines the maximum distance of the reflection.

5. Transparency
6. Material ID Parameters:
Use the slider to choose the smoothness level for the material.

7. Material Characteristics:
The material is visible or invisible.
The material either projects shadows or it does not.
The material either receives shadows or it does not.
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8. Shader/Textures Navigator:
For a material, this makes it possible to navigate between related Shader and Textures editors.

Expert Shader
Materials List: displays the materials of the scene.

1. Color Selector:
Click to select a diffusion color or enter numerical values (1 to 255) in the RGB fields.

2. Saturation:
Use the slider to choose the color saturation level.

3. Diffusion Color:
Another way to select a color is to click to choose a color from the system color picker.

4. Reflection, Shininess
Gives a reflective appearance to the material.
The reflection intensity is managed using gray scale values or RGB values from 0 to 255. Click on the selector to choose a color.
Entering a Limit value defines the maximum distance of the reflection.

5. Transparency
6. Neon:
Drag the slider to adjust the neon power or enter a value in the related field. Click on the selector to choose a
color.

NB: Neon color does not emit light.

7. Material ID Parameters:
Use the slider to choose the smoothness level for the material.

8. Material Characteristics:
The material is visible or invisible.
The material either projects shadows or it does not.
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The material either receives shadows or it does not.

9. Shader/Textures Navigator:
For a material, this makes it possible to navigate between related Shader and Textures editors.

NB: Before editing a color, click on the button associated with the command.

Shaders: Procedural, Mirror, Transparent, Marble, Lines
Materials List: displays the materials of the scene.

1. Color Selector:
Click to select a diffusion color or enter numerical values (1 to 255) in the RGB fields.

2. Saturation:
Use the slider to choose the color saturation level.

3. Color Picker:
Shader defined by 2, 3 colors or more (e.g. checkerboard).

4. Shininess
Drag the slider to make the material reflect its environment or enter a value in the related field.

5. Roughness:
Moving the slider lets more or less light move on the material.

6. Color Table:
Defines the gradient mode between 2 colors. The mixture depends on the Shader's geometry. e.g. Checkerboard, Lines, Stone, Marble, etc.
Click on the curve, keep the mouse button depressed and move to redraw the curve.
A horizontal line at the top or bottom of the table indicates that a single color is applied.
A diagonal straight line indicates a regular shading.
Flip: The
button turns the Shader around its object.
Scale: Moving the slider adjusts the Shader proportionately.

7. Material ID Parameters:
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Use the slider to choose the smoothness level for the material.

8. Material Characteristics:
The material is visible or invisible.
The material either projects shadows or it does not.
The material either receives shadows or it does not.

9. Shader/Textures Navigator:
For a material, this makes it possible to navigate between related Shader and Textures editors.

Luminous Glass Shader
Materials List: displays the materials of the scene.

1. Color Selector:
Click to select a color or enter numerical values (1 to 255) in the RGB fields.

2. Saturation:
Use the slider to choose the color saturation level.

3. Lighting Power:
Drag the slider to increase power or enter a value (values from 0.1 to 5000) in the related field. Click to
choose a color from the system color picker.

4. Transparency
5. Reflection, Shininess
Reflection: Drag the slider.When the diode is red, the material reflects its environment or enter a value in the
related field. Click on the diode to cancel the reflection effect.
Entering a Limit value defines the maximum distance of the reflection.
Shininess: Blurs the specular highlight, which is the spot of light that appears on shiny objects when illuminated. Drag the cursor or enter a value in the associated field.

6. Material ID Parameters:
Use the slider to choose the smoothness level for the material.

7. Material Characteristics:
The material is visible or invisible.
The material either projects shadows or it does not.
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The material either receives shadows or it does not.

8. Shader/Textures Navigator:
For a material, this makes it possible to navigate between related Shader and Textures editors.

Realistic Glass Shader
Materials List: displays the materials of the scene.

1. Color Selector:
Click to select a diffusion color or enter numerical values (1 to 255) in the RGB fields.

2. Saturation:
Use the slider to choose the color saturation level.

3. Transparency
4. Reflection, Shininess
Entering a Limit value defines the maximum distance of the reflection.

5. Fresnel Transition
6. Glazing Quality:
Allows a discontinuous reflection to be created when there is a break between several surfaces on the same
plane. This effect accentuates the realistic effect of reflection on a wall of glass.
Distortion size:
Determines the length of the undulation. Enter a value into the related field.
X/Y:
To orientate the undulation mostly on the X- or Y- axis or both. The slider allows the proportion to be varied. Enter a value into the related field.
Flatness:
Determines the amplitude of undulation. Enter a value in the related field.
Automatic glass detection:
When checked, finds the limits of a contiguous shape to generate a glazed surface.

7. Material Characteristics:
Smoothness: Use the slider to choose the smoothness level for the material.

8. Shader/Textures Navigator:
The material is visible or invisible.
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The material either projects shadows or it does not.
The material either receives shadows or it does not.

9. Shader/Textures Navigator:
For a material, this makes it possible to navigate between related Shader and Textures editors.

Editing Textures
A texture is an image or sequence that is imported onto a material. A material can receive one or more textures.

Materials List

Applying a texture is done either by:
l

Using the

Add Texture button in the Shaders inspector

l

l
l

Right clicking on the name of the material
and selecting the Add Texture...
option
By dragging/dropping the texture thumbnail from the Catalog to a material in Preview mode or in the list.
Dragging and dropping the texture from a location on the hard drive onto a material in Preview or in the list.

Deleting a texture is done either by:
l
l
l

Clicking on the
button to delete the current texture.
Using the Delete background key.
Right clicking the name of the texture and selecting Delete in the pop-up menu.

Texture Mapping
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1. Preview:
Displays the thumbnail of the selected Texture. The blue cross represents the anchoring point of the texture.
Clicking in the image repositions this point.

2. Rotation:
Use the circular cursor (Shift + Click, to step every 15°) to turn the texture on its axis or enter a value in the
related field.

3. Mix Color:
Check and click on the selector to choose a color.

4. Reflection
Move the slider to change the reflection or enter a value in the related field. When the diode is red, the texture
reflects its environment.
Double click on the red diode to cancel the effect.
Entering a Limit value defines the maximum distance of the reflection.

5. Shininess
Use the slider or enter a value into the related field.

6. Ambient:
Use the slider or enter a value into the related field.

7. Bump:
Use the slider or enter a value into the related field to simulate the effect of bumps or hollows on the surface
of the material using the levels of gray contained in the image.
Double click on the diode to cancel the effect.
Normal mapping

8. Transparency:
Apply a level of transparency to the texture or enter a value into the related field. Click on the diode to cancel
the effect.
Use Alpha Channel: Activates/deactivates the transparency of the alpha channel.
Using a transparency color: Click on the selector to choose a transparency color.

9. Scale:
Button
: The texture is automatically adjusted to cover the maximum surface of the material horizontally
and/or vertically.
The slider changes the texture scale from 50 to 200% of the current size. Or enter a value into the related
field.

10. Dimension, Spacing:
Width/Height:

Enter the size of the texture, clicking on
Horizontal/Vertical Spacing:

retains the proportions. Click again to cancel the limitation.

Used for repeated textures. Defines the size of the spacing between each repetition.
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Enter a spacing value as H and/or V. Clicking
itation.

keeps the same proportions. Click again to cancel the lim-

Flip:
horizontally or vertically inverts the texture with a mirror option between 2 repetitions.
Horizontal, Vertical repetition: duplicates the texture along the horizontal and/or vertical axis.
Horizontal Mirror, Vertical Mirror: Horizontally and/or vertically inverts each duplication.

11. Projection:
Adjusts the image to the surface on which it is placed. Automatically selects the adjustment best suited to the
project.

Planar: is applied to a plane.
Orthogonal: is applied to an element. If the element is composed of surface planes, the texture follows the
surface planes.
Vertical: vertical projection on the element. The horizontal parts receive the image while the vertical or tilted
parts are stretched.
Spherical: adopts a spherical form that depends on the size of the texture. Hence, it may leave empty spaces.
YCylindric: the texture is projected around the axis of a vertical cylinder.
XCylindric: the texture is projected around the axis of a horizontal cylinder.
UV: maintains the texture coordinates on an object coming from software that manages UV maps.
Planetary: vertical projection of the element while passing through the poles, without leaving spaces.

12. Shader/Textures Navigator:
For a material, this makes it possible to navigate between related Shader and Textures editors.

Reafect a Material
The geometry selected in the Preview window is used to reassign materials.
Use the toolbar
1.
2.

.

Create and name a new material:
Activate

3.
Choose the type of selection in the
rials or magic wand.

drop-down menu, by triangles, planes, parallel planes, objects, mate-

4.
In preview mode, click on the items you want to reassign with the new material.

NB: Elements making up an object cannot be selected.
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5.

Click on

to apply the material.

Cancel a Selection
6.

Click on

again

NB: The File > Use Reference File command does not recognize reassigned or renamed materials.

The Materials and Textures Pop-up Menus
The pop-up menu depends on the name of the material or texture clicked.

Material
l

Right-clicking on a material name displays the following pop-up menu:

Create Shader...
Opens the Create Shader dialog.

Apply to All Instances
Applies the modified material of an object to all identical objects in the scene.

Reset to Default
Applies the original material to the object.

Add Texture...
Open the dialog box and choose a TGA, JPEG, BMP, PNG, PICT, or Photoshop file.

Merge materials with Same Name
Materials with the same name will be replaced by the selected material.

Merge Material with the Same Shader
Materials with different names but having the same shader are grouped under the same name.

Merge Vertex
Merges superposed points of the polygons using this material.
(Avoids the problems of modeled object artifacts whose superposed points are not merged and allow the smoothing
of the polygons).

Visible
l

If unchecked, the material becomes invisible.
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Cast Shadow
If checked, the material casts shadows on the other elements.

Receive Shadow
If checked, the material receives the shadows cast from other elements.

Delete All Unused Material IDs
Clears the materials that are not assigned to the geometry.

Delete
Deletes the selected material.

NB: Does not delete a material from the original model.

Texture
l

Right-clicking on a texture name displays the following pop-up menu:

Delete: erases the related texture.
Merge Texture Origin: upper left, upper right, lower left, lower right, center.
Determines the texture's anchor point. In Preview, the origin is represented by a black cross.
In the thumbnail, the anchor point is represented by a blue cross.
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The Objects Inspector
Used to edit geometry, materials, coordinates, dimensions and animation settings
Editing the geometry from the list
There are two ways of displaying the elements in the scene: by Hierarchy or by Layer
n

n

By Hierarchy allows the user to select the elements making up the scene in view and edit them. See " The
Objects Inspector by Hierarchy" page 124
By Layer allows the attached objects to be ordered by layer. See " The Objects Inspector by Layer" page 126

NB: editing the scene information such as the infinite ground, movement of the origin, redimensioning of the model and the coordinates may be accessed via the Window menu.

In this chapter you will learn about the following subjects:
The Objects Inspector by Hierarchy
Geometry
Object
Saving a scene:
The Objects Inspector by Layer
Layers
Geometry
Object
Editing the Scene
Editing Objects
In the case of a Standard object:
Object Animation
Creating an Object from a selection of polygons
Selecting polygons
Creating the object
Canceling a Selection
The Objects List
Billboards
Availability:
Light Objects
Standard Objects
Object Animation
Vegetation Objects
Animated Character Objects
Behavior
Shader:

124
124
125
125
126
127
128
129
129
131
131
132
132
132
133
133
133
134
134
136
137
137
138
139
139
140

Coordinates
Object Animation
Instanced Object

140
140
140
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The Objects Inspector by Hierarchy
The elements listed represent the geometry of the scene and objects.
The contents of the inspector differs according to which option is selected from a list:
1. Scene geometry
2. Object added to the scene

Geometry

The name of a geometry selected in the list displays its coordinates, dimensions and animation parameters. These
parameters may not be edited.

NB: the settings related to the geometry cannot be edited (name, coordinates, dimensions).
l

Delete the geometry from the list: does not affect dependent objects
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Object

The object settings can be edited as they are independent of the scene geometry.

Geometry pop-up menu selected

When the geometry is selected in the list, right-clicking the layer name displays a popup menu with the following
options:
l

l

Use/Do not use as target: to define (depending on the activation in the viewpoint inspector) whether a geometry
element or an object is suitable for being used as a target for the cameras
Delete object from the list.

NB: multiple selection is available with these commands.
The objects are available in the Media catalog

Object geometry
1. Edit Object
2. Types of objects: Standard, Light, Vegetation, Animated person
3. Creating an Object

, Billboard.

Saving a scene:
To export a scene as an object, see Saving an AOF Document
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The Objects Inspector by Layer
Geometry elements are always contained in layers.
The layers come either from the CAD software, or are created in Artlantis.
The Inspector dialog changes according to which option is selected from a list.
There are three selection options:
1. Layers
2. Geometry
3. Objects.

Selecting more than one layer enables their visible/invisible status to be changed depending on the viewpoint.
Selecting multiple objects enables them to be moved to another layer.
Clicking the name of an object in the list makes its insertion point flash in the Preview window.

Renaming a layer
The name of the layer selected in the list is highlighted, select it to rename it.

NB: in Artlantis, renaming a layer created in the CAD software breaks the link to this layer. In this case,
modifications made using the "Use a reference file..." command will not be recognized.
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Layers

1. Layer data:
name, number of instances contained, number of triangles making up the geometry

2. Actions on layers
l

l

Use by default:
When you click the "Use by default" button, the layer selected becomes the default layer for dragged objects
dropped into the scene or objects created from the scene stored there.
Hide/Display in the current view: displays what is necessary for the active viewpoint. Advantage: improves the
display and rendering.

3. Layer type:
None, Objects, 3D Vegetation, Billboards, Animated objects, Light objects
When you drag and drop objects into the Preview window, they can be stored automatically in the layers.
This is done by telling these objects what their destination layer is beforehand.
When a project is opened, Artlantis always assigns a default layer, its name is displayed in bold. This layer
receives any object added into the scene until another layer is declared as the "Default layer".
However, you can automatically associate certain types of object with certain layers
None: by default, the component dragged and dropped into the scene is stored in the layer whose name is
shown in bold, except if this type of component has already been associated with a specific Objects, 3D
Vegetation, Billboards, Animated objects or Objects with light layer.
To define a specific layer which is to contain a certain type of component, a new layer must be created in the
list or an existing layer chosen, then in Layer type, select the type.
Any layer in the list can be chosen. In the list, the symbol concerned will be assigned to the layer icon.

Example: you create a new layer. Then in Layer type, you click on Objects. All components (objects)
dragged and dropped will be stored automatically in this layer.

4. Actions on the view containing the visible layer:
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Edit: depending on the layer selected, lists only the viewpoints where this layer is visible. In the popup menu,
select the name of the view. The Inspector changes to Viewpoint inspector and the selected view is displayed.
Activate: depending on the layer selected, lists only the viewpoints where this layer is visible. In the popup
menu, selecting the name of the view activates it without changing Inspector.

5. Scene information: Displays the edit dialog for the scene

Geometry

Right-clicking geometry contained in the layer displays a popup menu with the following options:

l

Use/Do not use as target: defines (depending on the activation in the viewpoint inspector) whether a geometry
element or an object is suitable for being used as a target for the cameras or lights.
Delete: deletes the selected geometry contained in the layer.

l

Move to: moves the geometry to another layer.

l

NB: the settings related to the geometry cannot be edited (name, coordinates, dimensions).

Object by Layer toolbar

Create a layer
1.
2.

Create a layer

in the layer list. A new layer is added, click on the name of the layer to rename it.

To delete a selected layer, click
When the layer contains geometry, a warning dialog offers to transfer the elements in this layer to another via a
popup menu or to delete all the elements it contains.

NB: renaming or deleting layers which have been created by the CAD software breaks the link with
it when the "Use a reference file..." command is used.
Creating an object

Selected layer popup menu
When a layer is selected in the list, right-clicking the layer name displays a popup menu which lets you:
l
l
l
l
l

Default: define this layer as default
Hide in the current view: makes the layer invisible for the current view.
Edit the view containing the layer: the inspector view changes to the Viewpoint Inspector.
Activate the view which has this layer visible: the view becomes active without changing the inspector.
Default layer for: defines the default type for this layer: Objects, 3D Vegetation, Billboards, Animated objects,
Light objects.
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l

Delete : deletes the selected layer, then displays the following dialog to move its content.

l

Delete all empty layers: deletes all layers which do not contain geometry.

NB: multiple selection is available with these commands.
Object
l

Types of objects: Standard, Light, Vegetation, Animated person
The objects are available in the Media catalog

, Billboard.

Editing the Scene
Data related to the whole scene is displayed using a command from the Window menu or from the Object inspector in
display mode by Layers.

1. Scene Information:
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l
l
l
l
l

File location:
Number of triangles making up the scene,
Number of triangles making up the objects,
Types and numbers of viewpoints,
Structure of Light, Heliodon and Material Groups.

2. Infinite Ground:
l

Checking/unchecking activates and deactivates the ground. The ground receives shadows,
Shaders and objects.

l

Click on the Altitude
cursor. Then, in the Preview window, click on the scene element
that will define the height of the ground, or enter a value into the related field.
Edit Shader selects the Ground Shader and activates Shader edit mode.

l

3. Transfer the origin of the anchor point:
l

Select the location of the new origin of the Scene.

Determine the object entry point (blue
ball)

Moves the scene origin.

Center X, Y and below

Center X, Y and above.

Center X, Y

Camera target.

NB: for an .aof the default anchor point can be changed in the 2D view.
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4. Scene Size:
Resizes: geometry, objects, cameras, lights, etc. No impact on the size of Shaders and textures.
Editing dimensions; if Keep proportions is checked, X, Y and Z remain homothetic.

5. Coordinates:
l

Model XYZ Position. Enter values in the related fields to move the scene origin.

l

Clicking on
locks them and clicking on
unlocks them.
Rotation: Pivots the scene along the x, y and z axes.
Shift+click and dragging the cursor restricts the movement to 15° steps.

l

Editing Objects
Select an object from either:
l
l
l

List of Objects
The Preview Window
The 2D View window

The inspector palette displays the information.

In the case of a Standard object:

1. Preview Thumbnail.
2. Edit Shaders...
l

Choose the material to edit from the list, the Objects inspector switches to Shaders mode.

3. X, Y, Z Coordinates
l

Position: Provides the x,y,z coordinates for the object's anchor point. Entering new values redefines
the position.

NB: for an .aof the default anchor point can be changed in the 2D view.
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l

Rotation: Pivots the object along the x, y and z axes.
Shift+click and dragging the cursor restricts the movement to 15° steps.

l

Clicking on

locks them and clicking on

unlocks them.

4. Dimensions: changes the length, width and height settings.
l

Click on the checkbox to maintain the proportions. Clicking again removes the restriction.

5. Animation Parameters:
Object Position: 3 options
Normal: The object always moves parallel to its starting position. (e.g. a vector that always retains its orientation regardless of the object's path).
Orientation on the Path: The object moves in x, y, z in the direction of the path (e.g. an aircraft performing a
loop).
Orientation on the path, X,Y only : The object moves in x, y, z in the direction of the path but always remains
parallel to ground level x,y (e.g. a helicopter taking off).

NB: using the timeline, in a single sequence, the object can change behavior several times.

Object Animation
See " The Timeline Window" page 78
See "Animatable Object Parameters" page 189

Creating an Object from a selection of polygons
From the geometry selected in the Preview window.

Selecting polygons
Use the toolbar in the object list
1.

Activate

.

2.

Choose the type of selection in the
drop-down menu, by triangles, planes, parallel planes, objects, materials or magic wand.
3. In Preview, click on the elements that will make up the object.

NB: an object cannot be created from elements already used for another object.
4.

Activate

.

NB: for an .aof the default anchor point can be changed in the 2D view.
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Creating the object

The object remains linked to the project but is saved either in the atl document, or in an independent aof file. In this
case, the aof file can be used in other projects.
1. Name the object
2. Create an internal object, or Create an external object (.aof). In this case select the location where it is to be
saved.
3. Destination layer: choose the layer for the new object.

NB: the geometry used to make up the object no longer exists since it has been converted to an
object.

NB: the use of the "Use a reference file..." command maintains control of the layers except in the following cases when:
in Artlantis:
- the geometry from the CAD or modeler software contained in a layer has been moved to another layer.
- the names of the layers or the geometry contained in the layers have been renamed.
in the CAD or modeler software:
- the layers have been renamed or deleted.

Canceling a Selection
l

Click on

again.

NB: geometry selection does not work on Artlantis objects.

The Objects List
Opens the list of object groups.
The geometry is displayed either by hierarchy or layer.
n

By Hierarchy lists the elements of the scene together with the associated objects.

n

By Layer lists the geometry of the scene by layer together with the associated objects.
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l

l
l

deletes the selected object (and its dependencies). Double-clicking on the object name edits the name.
Changing the dependence of an object in the hierarchy is done by dragging and dropping.
The objects can be placed in a hierarchy so the group of objects can be translated by moving the parent object
Objects are classified alphabetically. Clicking on "Name" at the top of the list reverses the alphabetical order of
the classification.

NB: The Delete, Undo/Redo commands are available on the object list.

Pop-up menu for objects:
l

Right-click on the name.

l

Define as target: forces a camera to use the object as a target.
In the list, the object will have a red target in front of it.
In the Coordinate Viewpoint inspector, select the target object from the drop-down menu. Select target.

Coordinates of the Perspective View Inspector:

l

The selected object has been created from the contextual menu as explained above.

Billboards
Billboards are composed of a surface plane and an image.

Availability:
Available in the Catalog Manager, "2D Billboards" folder.
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Two types of Billboards
l
l

Vertical with relation to the ground (People and Vegetation).
Flat, which lies flat on the receiving surface (Signs and Pictograms).

1. Preview Thumbnail.
2. Horizontal and/or vertical symmetry.
3. Size of the element:
l

Using the slider or by entering a value in the field (to go beyond the limits of the slider, type in a value.
The values of the slider will be updated accordingly).

4. Color:
Use the menu to change the color.

5. Transparency:
Used to render a Billboard with greater or lesser transparency depending on the desired level of transparency: values from 0 to 100. 0 means opaque.

6. Display: Display Parameters in Preview
l

Brightness: for changing brightness values from -0.25 to 0.25.

l

Contrast: for changing contrast values from 0.5 to 1.5.

7. Coordinates:
Position:
l Provides the x,y,z coordinates for the object's anchor point. Entering new values redefines the position.
l
l

Clicking on
locks the coordinates and clicking on
unlocks them.
X, Y, Z Rotation: Pivots the object.
Shift+click and dragging the cursor restricts the movement to 15° step.
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l

Check

to restrict the billboard to always face the camera.

8. Animation settings

Light Objects

1. Preview Thumbnail.
2. Edit Shaders...
l

Choose the material to edit from the list, the Objects inspector switches to Shaders mode.

3. Light Objects...
l

Choose the light to edit from the list, the Objects inspector switches to Lights mode.

4. X, Y, Z Coordinates
l

Position: Provides the x,y,z coordinates for the object's anchor point. Entering new values redefines the position.

l

Clicking on
locks them and clicking on
unlocks them.
Rotation: Pivots the object along the x, y and z axes.
Shift+click and dragging the cursor restricts the movement to 15° step.

l

5. Dimensions: for modifying the parameters: length, width, height.
l

Click on the checkbox to maintain the proportions. Clicking again removes the restriction.

6. Animation settings

NB: using the Timeline, in a single sequence, the object can change behavior several times.
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NB: A light object's light cannot be deleted from the Lights inspector list. This must be done from the
Objects list.
See " The Timeline Window" page 78
See "Editing Paths" page 61
See "Animatable Light Parameters" page 189

Standard Objects

1. Preview Thumbnail.
2. Edit Shaders...
l

Choose the material to edit from the list, the Objects inspector switches to Shaders mode.

3. X, Y, Z Coordinates
l

Position: Provides the x,y,z coordinates for the object's anchor point. Entering new values redefines the position.

l

Clicking on
locks them and clicking on
unlocks them.
Rotation: Pivots the object along the x, y and z axes.
Shift+click and dragging the cursor restricts the movement to 15° step.

l

4. Dimensions: for modifying the parameters: length, width, height.
l

Click on the checkbox to maintain the proportions. Clicking again removes the restriction.

5. Animation settings

NB: using the Timeline, in a single sequence, the object can change behavior several times.

Object Animation
See " The Timeline Window" page 78
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See "Editing Paths" page 68
See "Animatable Object Parameters" page 189

Vegetation Objects
Available in the media manager "Free VB Visual Plants Samples" Vol. 1 and 2.

1. Preview Thumbnail.
2. Height:
l

Using the slider or by entering a value in the field.

3. Transparency:
Used to render a vegetation object with greater or lesser transparency depending on the desired level of transparency. values from 0 to 100. 0 means opaque.

NB: When the slider is at the end, typing a higher numerical value allows the sizes to go beyond the
end. The slider values will be updated accordingly.

4. Representation date:
l

Choose: active heliodon date or calendar date.
n
n

Heliodon date: use the date of the active heliodon
Calendar: use the selected date.

5. X, Y, Z Coordinates
l

Position: Provides the x,y,z coordinates for the object's anchor point. Entering new values redefines the position.

l

Clicking on
locks them and clicking on
unlocks them.
Rotation: Pivots the object along the x, y and z axes.
Shift+click and dragging the cursor restricts the movement to 15° step.

l
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6. Animation settings

NB: using the Timeline, in a single sequence, the object can change behavior several times.
See " The Timeline Window" page 78
See "Working with Object Animations in 2D View" page 68
See "Animatable Object Parameters" page 189

Animated Character Objects
l

Available in the Media Catalog: Exterior, Furniture, Transport...

1. Preview Thumbnail.
2. Rotation:
l

Pivot the object on itself or enter a numerical value.
Shift +click dragged using the cursor limits the movement to a step of 15°.

3. Height:
l

Using the slider or by entering a value in the field.

NB: When the slider is at the end, typing a higher numerical value allows the sizes to go beyond the end. The
slider values will be updated accordingly.

4. Color:
l

Use the menu to choose the clothing color.

Behavior
5. Behavior: Use the menu to choose the character's attitude: standing, sitting, running, etc.
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Shader:
6. Shader
l

Select the material to be edited from the list.

7. Reflection, Shininess, Bump:
l

l
l

Reflection: drag the slider. When the diode is red, the texture reflects its environment. Double click on the red
diode to cancel the effect.
Shininess: drag the slider to make the material become bright or enter a value in the related field.
Bump: drag the slider to apply bump to materials or enter a value in the related field. Click on the red diode to
cancel the effect.

8. Mix Color:
l

Check and click on the selector to choose a color.

Coordinates
9. X, Y, Z Coordinates
l

Position: Provides the x,y,z coordinates for the object's anchor point. Entering new values redefines the position.

l

Clicking on

locks them and clicking on

unlocks them.

Object Animation
See " The Timeline Window" page 78
See "Editing Paths" page 68
See "Animatable Object Parameters" page 189

Instanced Object
Principle: 2 objects: one table, one vase. The vase is placed on the table. If the table is moved, the vase follows the
movement

Instancing an Object

Using drag and drop:
l
l
l

In Preview to another object
In the list to the name of an object.
In the list, the instanced object is shown off-center to the right under the reference object.

Delete a Dependency
l

Drag and drop the dependant object to the "Model" name at the top of the list.
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NB: the level of instances is unlimited.
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The Heliodons Inspector
Manages the calculations for sunshine according to the position of the sun, determined by the place, time and type of
sunshine. One heliodon may be associated with one or more viewpoints.
In this chapter you will learn about the following subjects:
City Editor
The Heliodons List
Advanced Heliodon Parameters

145
145
146

Heliodons List: for handling heliodons on the list shown.

Sunlight:
1. Rays of the sun projections: Location, Manual or 45°.
l

Location: Select a city from the local menu.

2. City editor: edits the list of cities
3. Set date and time:
l

either by clicking the arrows, editing the date dd/mm/yyyy and time hh:ss, or by moving the associated sliders.

4. Sunlight Power:
l

Move the slider or type in a percentage value in the field. Clicking on the red diode resets the power to its initial
value.

5. Color Filter:
l

Click on the color box to modify the color of the light coming from the sky. All elements in the scene receiving
projected light will be tinted with this color.
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NB: Does not tint the sky.
6. Shadows:
l

The heliodon can cast shadows.The slider enables you to vary the shadows from hard to soft.

Light from the sky:
7. Power of light from the sky:
l

Move the slider or type in a percentage value in the field. Clicking on the red diode resets the power to its initial
value.

8. Color Filter:
l

Click on the color box to modify the color of the light coming from the sky.

NB: Tints the scene elements but not the sky.

Clouds:
9. 4 types of cloud Cirrus, Stratus, Cumulus, Cirrocumulus.
l

Move the slider or type a value into the numeric field to vary the size of the clouds.
Example: editing a 3D sky.

10. Cloud distribution:
l

Click on

to vary the distribution of the clouds or enter a value in the numeric field.

11. Clouds mask sun:
l

If the box is checked, the sun remains behind the clouds. The sun rays will not be projected.

12. Click to open the Advanced Parameters dialog: pollution, halos, fog

NB: clouds are visible in the current view if the 3D Sky option is set in the Viewpoints inspector.

6. Shadows:
City Editor
Heliodon List
Advanced heliodon settings

NB: editing the scene information such as the infinite ground, movement of the origin, redimensioning of
the model and the coordinates may be accessed via the Window menu.

Heliodon Animation
See " The Timeline Window" page 78
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See "Animatable Heliodon Parameters" page 188

City Editor

World Map
l

The chosen city is circled in red. Clicking on the map points to the closest city.
n
n

Add creates a "New City":
Double click on "New City" to rename it. Adjust the longitude and latitude parameters.

NB: Alt+click to edit the longitude and latitude of the current city.
The mouse wheel provides dynamic zoom capability.

l

Delete deletes a city

City
l

Lists all cities. Clicking on a name selects this city and the position is instantaneously effective on the world
map.

Longitude and latitude
l

Geographic position of the current city.

GMT
l

Time difference (Greenwich Mean Time).

+ 1 in summer

The Heliodons List
opens the heliodons list. Double-click on the desired name to change it.
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adds a heliodon,
deletes the selected heliodon.
The heliodons are classified alphabetically, clicking on "Name" at the top of the list modifies the alphabetical order of
the classification.
l

Right-clicking on a heliodon displays the contextual menu:

Delete: The heliodon is removed from the list.
Activate for theCurrent View: Activates the heliodon for the current view (Name in bold).
Deactivate for Current View: Deactivates the heliodon for the current view.
Edit View Using This Heliodon: to choose a viewpoint, the inspector switches to Perspectives or Parallel
views, Panoramas, VR Objects or Animations mode.
Activate View Using This Heliodon: displays the chosen viewpoint in the preview window (the inspector
remains in Heliodon mode).
The Cut/Copy/Paste shortcuts are effective for the list.

Advanced Heliodon Parameters

Sky:
1. Pollution factor:
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l

Move the slider or type in a percentage value in the field.

2. Merge Sky Color With:
l

Check the box to activate/deactivate the effect. Click the colored box to choose a color. The color is mixed with
the calculated sky color.

3. Luminous halo:
l
l

Check the box to activate/deactivate the effect.
Choose effect: Click on one of the 4 thumbnails.

4. Halo Power:
l

Move the Power slider or type in a value between 0 and 100%.

Fog: set fog parameters
l

Check the box to activate/deactivate the effect.

5. Starting distance: click
then, in the Preview window, click on the point from which the fog will be able to
be perceived, or enter a numeric value in the field.
6. Visibility distance: visibility distance begins at the starting distance. It provides the fog with a volumetric effect.
7. Altitude: Altitude takes effect from bottom to top. It depends upon the starting distance and the visibility distance.
8. Color: for assigning a color to the fog.

Animation settings:
used to animate the movement of the wind along with its direction.
9. Wind
l
l
l

Check the box to activate/deactivate the effect.
Movement speed values go from 0 to 100.
The direction is specified using the circular slider, direction being relative to project North (see 2D view).

NB: effect only in Artlantis Studio in animation mode
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L’inspecteur des Lumières
Éditer les éclairages en fonction des points de vue. Réglages interactifs et résultats immédiats dans la fenêtre de Prévisualisation. L’utilisation du modèle lumineux approprié et bien ajusté valorise le travail effectué sur les matières.
Les groupes de lumières peuvent être attachés à 1 ou plusieurs points de vue. Les lumières se caractérisent par une
limite d’éclairement et une zone d’éclairement maximale.
In this chapter you will learn about the following subjects:
13 - The Lights Inspector
List of Lights

149
150

13 - The Lights Inspector
Edit lighting schemes based on viewpoints. Interactive settings and immediate results in the Preview window. Using
the appropriate and correctly adjusted light model promotes the work carried out on the materials. Light groups may
be attached to 1 or more viewpoints. The lights are characterized by an illumination limit and a maximum illumination
area.
Lights List: for handling lights on the list shown.

Lighting

1. Select projection type
determines the lighting projection (falloff) from 9 predefined types

2. On/Off
3. Color:
Double click to modify the source color.

4. Source power
Values from 1 to 1,000,000. Move the slider to change the power or enter a value.

5. Attenuation Distance
Calculates the attenuation distance for the lighting power.
Between the attenuation distance and source, the lighting power remains constant and at maximum.
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The distance beyond distance A corresponds to the gradual diminishing of lighting power at 1/d². When the
attenuation value equals 0, the light diminishes at 1/ d² beginning at the light source.
Enter the distance in the numerical field (current unit).

NB: in this area, the illumination principle is based on reality.The closer an object is placed to the
light source, the more illuminated it appears.

6. Change the Lighting Angle:
By sliding from 10 to 360° or by typing in a numerical value.
Example: A value of 360° provides an omnidirectional light.

7. Shadow projection
Activate/Deactivate shadow projection: Click on the box to check it.

8. Shadow type
Sharpness slider on the edge of the illuminated area. Values from 0 (diffuse area between the shadow area
and the illuminated area) to 100 (straight limit). Accepts a numerical value.

9. Luminous halo:
Activate/Deactivate: Click on the box to check it.
Choose effect: Click on one of the thumbnails:
Halo Power: Move the Power slider or type in a value between 10 and 200%.

10. X, Y, Z Coordinates: of the position of the light source and its target.
Clicking on
locks them and clicking on
unlocks them.
Activated target: choose between target on a fixed vertex or on an object defined as target.

NB: editing the scene information such as the infinite ground, movement of the origin, redimensioning of
the model and the coordinates may be accessed via the Window menu.

Animations:
See "Editing Paths" page 61
See " The Timeline Window" page 78
Preview Window Shortcuts
See "General Preview Display Shortcuts" page 203
See "Animatable Light Parameters" page 189

List of Lights
opens the list of light groups.
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The groups and their lights are classified alphabetically, clicking on "Name" at the top of the list inverts the alphabetical order of the classification.
l

Double-click on the name of a group or a light to edit the name.

l

Moving a light from a group to another group is done by dragging and dropping.

l

l

l

adds a light group,
adds a light at the current camera position if a group is selected. Duplicate the light if a light is selected..
deletes the selected light or group.

Light Group Pop-up Menu:
l

Right-clicking on the name of the group displays the contextual menu:

Paste : Pastes the clipboard contents
Delete: removes the selected elements.
Activate/Deactivate for Current View: the group takes part or otherwise in the lighting of the current view.
Edit View Using This Light Group: Choose the view point, the inspector switches to Perspectives or Parallel views, Panoramas, VR Objects or Animations.

Light Pop-up Menu:
l

Right-clicking on the name of the light displays the contextual menu:

Activate/Turn off: the light
Duplicate: Creates a light identical to the current light.
Cut: The cut light is stored in the clipboard.
Copy: The copied light is stored in the clipboard.
Delete: Removes the selected lights.
Edit View Using This Light : Choose a viewpoint from the list. The chosen viewpoint is displayed in the preview window.The inspector switches to Perspectives, Parallel views, Panoramas, VR Objects or
Animations mode accordingly.
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Selection and multiple editing of lights:

The Cut/Copy/Paste shortcuts are effective for the list.
To instantaneously assign a setting to several sources.
Select the sources by using:
Cmd click for a discrete selection. Shift click for a continuous selection.
The multiple selection is represented by hatching icons as well as dots in the numerical fields.
Change a parameter, it will be changed for all selected lights.
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The Site Insertion Tool
In the Perspectives inspector , Insertion enables the user to position a camera precisely vis-a-vis a model or photo.
Position a background image before using this command.
In this chapter you will learn about the following subjects:
Step 1 - Setting the Axis Markers in the 2D View
Step 2 - Setting the Tag in the Preview Window
Step 3 - Running the Insertion Calculation

153
154
155

Opening the insertion command

l
l

Click on
The insertion dialog enables you to define the focal distance of the image, gives you the option of adjusting the
axes, and allows you to choose the reference axis, display the model and run/stop the calculation.

NB: When opening the dialog, the model from the preview window is hidden. The background image
remains, with a marker for the axes, which appear in red, green and blue.
Insertion is carried out in 2 steps: placement of a trihedron into the 2D view and into the Preview window.

Step 1 - Setting the Axis Markers in the 2D View
Setting the orthonormal marker on the geometry is performed in 2 steps in top view and in another view. If needed, in
the top view, pivoting one of the red or green axes will rotate the marker on the origin.
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The changes made to the axes in 2D View are not updated in the Preview window. This is why we must also set the
marker in this window. See step 2.

Step 2 - Setting the Tag in the Preview Window

Place the origin of the axis marker on the photo, then pivot the red, green and blue axes one by one.

NB: Make sure that the positions of the axes in 2D View and Preview do not conflict.
In the insertion dialog: Depending on the placement of the axes in preview, choose one of the following two viewing options:
The Y axis moves away from
Determine the axis

or towards

the camera.

that will serve as a reference for sizing the 3D model in relation to the back-

ground image. Then, in the Preview window, adjust the size to the model by moving the yellow handle
. Do
the same in 2D View.
In the Preview Window: The magnifying glass helps you place the axis marker precisely on the background image.
To activate the magnifying glass, turn the mouse wheel. Each incrementation increases the zoom from 2x up to a maximum of 8x.
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Step 3 - Running the Insertion Calculation
In the insertion dialog, check
. The model displays in Preview, and then launch
. At any
time, the axes can be modified in real time in the Preview and 2D View windows. If the setting appears incorrect,

modify the value of the camera focus
it directly into the appropriate field.

, adjust the slider or, if you know the value, re-enter

stops the calculation.

NB: in order to avoid any inadvertent modification, when the insertion dialog is closed, the view locks automatically.
To unlock it in the Perspectives inspector, open Coordinates, then click on the padlock

.

To restart from the beginning, use the Cancel button.
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Post-Production Effect Filters
Enables the user to apply effect filters to the current view:
l
l
l

The effects are added among them, as well as to the parameters set in the viewpoint inspectors.
The Post-Production effects are "viewpoint dependent".Their settings do not affect other viewpoints.
The check boxes activate/deactivate the effects.

In this chapter you will learn about the following subjects:
Examples of Effects in Post-Production

158

1. Image settings
Use the sliders or enter numeric values to set Contrast, Brightness and Saturation. Values from -100 to
100.
Clicking on the red diode cancels the effect.
The Mix Color box enables you to select a tint mix from the color picker, which will cover the entire image.

2. Exposure
Exposure: Determines the amount of light that enters the camera.
Size: Fluffs the effect to a greater or lesser extent.
Values from 0 to 100 for these two settings.

3. Grain:
Brightness: Gives the image a granular appearance.
Size: Determines the size of the grains.
Values from 0 to 100 for these two settings.
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4. Edge and pastel
Provides a photorealistic rendering mixed with crayon, or a completely crayoned rendering.
Edge intensity: Marks more or less the weight of the lines that determine the geometry contours.
Transparency: More or less masks the geometry while retaining the intensity of the contour and the pastel
effect.
Pastel Effect: Provides a crayoned rendering effect.
Values from 0 to 100 for these three settings.
Validate or cancel these settings to close the dialog again.

5. Saved settings
Define as default/Default settings/Apply to all perspective viewpoints :
Respectively allow the user to revisit Artlantis initial settings, to define current settings as the default or propagate these settings to all other perspectives.

NB: Post-production effects are immediately visible in the Preview window.
When rendering, Artlantis always calculates in photorealistic rendering and applies the filters when the calculation is
finished.
Examples of Renderings

Examples of Effects in Post-Production
The effects can combine together to provide extremely rich variety.

Starting Photorealistic render

Desaturation
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Contrast brightness and saturation

Post-Production Effect Filters - Examples of Effects in Post-Production

Contrast brightness and saturation

Contour and pastel

Contour and transparency

Contour transparency and pastel

Pastel

Transparency and pastel

Exposure

Grain
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Grain exposure contour and transparency
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Contour with no transparency

Rendering
In this chapter you will learn about the following subjects:
Perspective Rendering Parameters
Viewpoint rendering settings in Expert mode in the "Photorealistic" engine
Render
Rendering Animations
Artlantis Batch Render
The Batch Rendering Window
The Partial Rendering Window
Parallel View Rendering Settings
Panorama Rendering Settings
VR Object Rendering Settings
Animation Rendering Settings

161
162
165
165
166
167
169
169
171
172
173

Perspective Rendering Parameters
Accessible by:
l

Clicking the icon:
available in the Perspectives inspector: The set values determine the rendering and display in the Preview window.

1. Display of rendering options for the "realistic photo" engine in the current mode
Rendering size
Print Resolution for Perspective View

2. Anti-aliasing
Anti-aliasing: anti-aliasing Normal / High.

Tip: to save calculation time, select a low value while increasing the Width/Height of the rendering.
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3. Radiosity
The calculation times depend on the value chosen.
This menu allows you to set the precision parameters with predefined values. I you change the values with the sliders
or the text fields, the menu will be set to custom.
Precision : Normal / Average / High / Custom .
Lighting : Interior / Exterior / Custom.

NB: these settings have a very strong influence on the rendering time.

Tip: Calculate small-sized images or use the Batch Rendering command.

4. Application settings
Define as default / Default settings / Apply to all viewpoints for the selected inspector :
Respectively allow the user to define current settings as the default, to use the default settings or propagate these settings to all other views for the inspector concerned.

NB: the display of options in expert mode is activated in the Preferences.dialog.

Viewpoint rendering settings in Expert mode in the "Photorealistic" engine
l

Click the icon:
available in the viewpoint and animation inspectors. The set values determine the rendering
and displaying in the Preview window.

NB: the display of options in expert mode is activated in the Preferences dialog.
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1. Display of options in standard mode
Rendering size
Print Resolution for Perspective View

2. Anti-aliasing
Anti-aliasing: Anti-aliasing Low/High.

Tip: To save calculation time, select a low value while increasing the Width/Height of the rendering.

3. Radiosity
The calculation times depend on the value chosen.
This menu allows you to set the precision parameters with predefined values. I you change the values with the sliders
or the text fields, the menu will be set to custom.
Precision: Normal/Average/High/Custom.

NB: these settings have a very strong influence on the rendering time.

Tip: Calculate small-sized images or use the Batch Rendering command.
l

Widened oversampling: Values from 96 to 8 pixels.
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The radiosity is calculated over a small number of pixels, the others are extrapolated. This distance represents
the mean distance in pixels between two points where radiosity is calculated. The lower the distance, the
more the density of calculated pixels increases.

NB: these settings have a very strong influence on the rendering time.
l

Reduced oversampling: Values from 0 to 48 pixels.
This is the radiosity from near surfaces (e.g. the corner between 2 walls). This requires special processing
enabling shadow quality to be refined. The value selected represents the processing range. If 0, no calculation
is carried out. The larger the value, the better will be the calculation of shadows with regard to radiosity.

NB: these settings have a strong influence on the rendering time.
Lighting: Interior/Exterior/Custom.
These settings affect the general ambient lighting for the scene. They are used to precisely control how the scene is
exhibited.
The predefined settings Interior/Exterior give default lighting settings depending on the space chosen.
The Custom setting is used for when the user opens a file prior to version 3 of Artlantis or when the lighting values
have been changed in expert mode.

NB: these parameters do not affect the calculation times.
Lighting power:
l

l

l

First rebound: values from 1 to 16.
Controls the radiosity power of the first rebound (affects all surfaces receiving direct light from a heliodon or
light sources).
Next rebounds: values from 1 to 16.
Controls the radiosity power of all rebounds after the first. This affects surfaces receiving indirect light.
Increasing the number of rebounds gives more light, particularly for interior scenes.
Attenuation: values from 0 to 1.
Controls absorption of light after one or more surface rebounds. A low value increases the contrast of the
scene thus allowing strong shadows to be cast in an interior scene lit by indirect lighting.

NB: this parameter has almost no effect on exterior scenes.
l

Color transfer: values from 0 to 1.
Controls the transfer of colors between surfaces.
Reducing the value desaturates the colors.

4. Application settings
l

Define as default/Default settings/Apply to all perspective viewpoints:
Respectively allow the user to define current settings as the default, to use the default settings or propagate
these settings to all other views for the inspector concerned.
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Render
Inspector Menu > Render

Specify the name, destination of the file and format in the dialog box: JPEG*, BMP*, TGA, PICT, TIFF, Piranesi,
Photoshop**.

NB: * formats that do use the alpha channel. ** Photoshop PSD multi-layer format.
l
l

l

Clicking on Options... opens the Rendering Parameters dialog.
Render Now: Opens the rendering window, then displays the rendering progress and the estimated and
elapsed computation times. To stop the rendering click on the close box of the window.
Render later:
Postpones the rendering of the current viewpoint, the document is automatically saved. Rendering will be
done using Artlantis Batch Render.

NB: Batch renderings are managed later in the Inspector menu > Batch renderings.... They are processed
by Artlantis Batch Render.

Rendering Animations
Inspector Menu > Render

Format:
l

Specify the name, destination of the file and format in the dialog box: MOV, JPG, TGA

Compression Parameters:
l

Choose a Codec and a compression quality.
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Quality:
l

Choose a compression rate:

For low compression, move the slide to the left. For high compression, move it to the right.
l
l

l

Clicking on Options... opens the Rendering Parameters dialog.
Render opens the rendering window
Shows the progress and the estimated and elapsed time of calculation. Work on the project cannot continue parallel to the renderings.
Postponed rendering saves the document.
Postpones the rendering of the current animation.

Stop Rendering in Progress.
Click on the "Close" box.

NB: Batch renderings are managed later in the Inspector menu > Batch renderings.... . They are processed by Artlantis Batch Render.

Artlantis Batch Render
Artlantis Batch Render is an application that is independent of Artlantis. It launches the Artlantis batch renderings
calculation.
As soon as it is launched, Artlantis Batch Render starts the renderings on standby.
The dialog box makes it possible to track the progress of the listed renderings.Each rendering displays a small progress image (1). A report (2) provides details on:
l
l
l

The location of the document and the image calculated on the disk.
The size of each image and the time it took to render.
Potential problems with the location of textures, Shaders, etc.Quit
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Quit
l

The Quit button closes the application, even if a calculation is in progress. The interrupted calculation information remains in the batch render document (BatchRendererDocument.xml). Relaunching Artlantis Batch
Render will restart where it was stopped.

Pause
l

Stops the image calculation in progress.

Resume
l

Resumes the currently paused image calculation.

The Batch Rendering Window
All batch renders are processed by the "Artlantis Batch Render" application.

Inspector Menu > Batch Rendering.
The Artlantis rendering manager displays the list of items that are to be processed.
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Toolbars
l

l
l

l

l
l
l

Deletes the selected view
Mark the selected view as needed to be calculated, even if it has already been rendered.
Indexed: names of renderings with the same name will be indexed numerically
or
Replaced: the name of a render with the same name will replace the existing file.

of the current project to the list of views that need to be rendered.
Destination: the destination of the rendering file can be redefined by clicking on the Folder button.
Image type: to redefine the rendering image format: JPEG, BMP, TGA, PICT, TIFF, Photoshop, Piranesi or
movie formats.

Viewpoints List:
l

Check the box opposite the name of the image in the list. This image will be rendered later.
n
n
n

Document name: the name of the atl file
View Name: The name of the viewpoint
Kind: type of viewpoint; Perspective, Parallel, Panorama, Animation, VR object.
Diodes: color codes

Diode

Status

Gray

Not rendered yet

Green

Rendered

Orange

Error during rendering
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Comments
Waiting for processing by Artlantis Batch Render if the box is
checked.

Check the information at the bottom of the Batch Rendering window

Rendering - The Partial Rendering Window

Red

Not rendered due to one or more
errors

Diodes: color codes
Check the information at the bottom of the Batch Rendering window

The Partial Rendering Window
Calculates part of the content of the Preview window.

Inspector Menu > Partial Render
1. Draw a rectangle in the Preview Window. The Render window showing the progress is displayed.

2. Defining the rectangle

3. Render window showing the progress of the calculation.

Parallel View Rendering Settings
Accessible by:
l

Clicking the icon:
available in the Parallel Views inspector. The set values determine the rendering and
displaying in the Preview window.
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1. Display of rendering options for the "realistic photo" engine in the current mode
Same parameters as for rendering Perspectives, except for printing.
Rendering size
Print Resolution for Parallel View

2. Anti-aliasing
Anti-aliasing: anti-aliasing Normal / High.

Tip: to save calculation time, select a low value while increasing the Width/Height of the rendering.

3. Radiosity
The calculation times depend on the value chosen.
This menu allows you to set the precision parameters with predefined values. I you change the values with the sliders
or the text fields, the menu will be set to custom.
Precision : Normal / Average / High / Custom .
Lighting : Interior / Exterior / Custom.

NB: these settings have a very strong influence on the rendering time.

Tip: Calculate small-sized images or use the Batch Rendering command.

4. Application settings
Define as default / Default settings / Apply to all viewpoints for the selected inspector :
Respectively allow the user to define current settings as the default, to use the default settings or propagate these settings to all other views for the inspector concerned.

NB: the display of options in expert mode is activated in the Preferences.dialog.
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Panorama Rendering Settings
Accessible by:
l

Click the icon:
available in the Panorama inspector. The set values determine the rendering and display in
the Preview window.

1. Display of rendering options for the "realistic photo" engine in the current mode
Rendering size
Resolution of rendered image

2. Anti-aliasing
Anti-aliasing: anti-aliasing Normal / High.

Tip: to save calculation time, select a low value while increasing the Width/Height of the rendering.

3. Radiosity
The calculation times depend on the value chosen.
This menu allows you to set the precision parameters with predefined values. I you change the values with the sliders
or the text fields, the menu will be set to custom.
Precision : Normal / Average / High / Custom .
Lighting : Interior / Exterior / Custom.

NB: these settings have a very strong influence on the rendering time.

Tip: Calculate small-sized images or use the Batch Rendering command.

4. Application settings
Define as default / Default settings / Apply to all viewpoints for the selected inspector :
Respectively allow the user to define current settings as the default, to use the default settings or propagate these settings to all other views for the inspector concerned.
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NB: the display of options in expert mode is activated in the Preferences.dialog.

VR Object Rendering Settings
Accessible by:
l

Click the icon:
available in the VR Object inspector: The set values determine the rendering and display
in the Preview window.

1. Display of rendering options for the "realistic photo" engine in the current mode
Rendering size
Number of images: Information on the number of images to be rendered to make up the VR objects depending on vertical and horizontal step.

2. Anti-aliasing
Anti-aliasing: anti-aliasing Normal / High.

Tip: to save calculation time, select a low value while increasing the Width/Height of the rendering.

3. Radiosity
The calculation times depend on the value chosen.
This menu allows you to set the precision parameters with predefined values. I you change the values with the sliders
or the text fields, the menu will be set to custom.
Precision : Normal / Average / High / Custom .
Lighting : Interior / Exterior / Custom.

NB: these settings have a very strong influence on the rendering time.

Tip: Calculate small-sized images or use the Batch Rendering command.
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4. Application settings
Define as default / Default settings / Apply to all viewpoints for the selected inspector :
Respectively allow the user to define current settings as the default, to use the default settings or propagate these settings to all other views for the inspector concerned.

NB: the display of options in expert mode is activated in the Preferences.dialog.

Animation Rendering Settings
Accessible by:
l

Click the icon:
available in the Animations inspector. The set values determine the rendering and display
in the Preview window.

1. Display of rendering options for the "realistic photo" engine in the current mode
Film size
l
l

Select a size from the menu or enter the width and height in pixels.
Increase/decrease the values by 2 by clicking on the

signs.

Render from X to Y Image. Enter the numbers of the corresponding images to calculate a portion of the sequence.
First Frame is set to 0.
Number of images: Information on the number of images or selected frames to be rendered to make up the animation.

2. Anti-aliasing
Anti-aliasing: anti-aliasing Normal / High.

Tip: to save calculation time, select a low value while increasing the Width/Height of the rendering.

3. Radiosity
The calculation times depend on the value chosen.
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This menu allows you to set the precision parameters with predefined values. I you change the values with the sliders
or the text fields, the menu will be set to custom.
Precision : Normal / Average / High / Custom .
Lighting : Interior / Exterior / Custom.

NB: these settings have a very strong influence on the rendering time.

Tip: Calculate small-sized images or use the Batch Rendering command.

4. Application settings
Define as default / Default settings / Apply to all viewpoints for the selected inspector :
Respectively allow the user to define current settings as the default, to use the default settings or propagate these settings to all other views for the inspector concerned.

NB: the display of options in expert mode is activated in the Preferences.dialog.
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In this chapter you will learn about the following subjects:
Panorama List

176

Panorama List: for handling panoramas on the list shown.

1. Panorama
Focal Length: Changes the focal length when the slider is used or a value is entered in mm or degrees
(adjusts the angular opening of the camera).
Depth of Field: click
then, in the Preview window, click to define the clear point of the scene, with the
rest remaining blurred. The cursor adjusts the blur amount.
Clipping Box: for defining clipping planes.
Show: in 2D View
Activate: Representation in Preview mode

2. Lighting
To handle light schemes linked to the view, select them from the drop-down menus.
Heliodon: links a heliodon to the view. Selecting "None" deactivates the heliodon.
Light Group: Links one or more light groups to the view. Selecting "None" deactivates the light groups.
Neon Shaders: Links one or more Neon Shaders to the view. Selecting "None" deactivates the lighting.

3. Environment
Handles the background and foreground of the scene.
Define a background: Background type: 3D Sky, Gradient, 2D Image, 3D Image, 3D Cubic
Foreground Images

4. Visible layers: check them in the drop-down menu.
5. Coordinates
Camera XYZ Position.
Clicking on

locks them and clicking on

unlocks them.
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6. Post-production
Applies effects to the current viewpoint: The effects combine into, as well as with the parameters set in the
inspector.
Rendering
Settings
7.
Prepares the document for final rendering.

NB: editing the scene information such as the infinite ground, movement of the origin, redimensioning of the model and the coordinates may be accessed via the Window menu.

Panorama List
opens the panorama list. Each is displayed by name and preview thumbnail.

l

To edit, double-click on the name.

l

adds a panorama,

deletes it.

Panorama Pop-up Menu
l

Right-clicking on a view displays the pop-up menu:

Duplicate: use the original to create a new superimposed panorama.
Delete: the panorama is removed from the list.
Add to the Perspectives List:
Add to the Parallel Views list:
Add to the VRObject list:

Page - 176

The Panorama Inspector - Panorama List

Add to the Animation list:
Depending on the option selected, adds current view from Panoramas to Perspectives, Parallel Views, VR
Objects or Animations.
Edit light: select a light, the inspector palette switches to Lights mode and the light is selected.
Edit Heliodon: The palette inspector switches to Heliodon mode and the heliodon is selected.
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The VR Objects Inspector
Manages viewpoints defined by a camera, a target and a focal length. Each viewpoint is considered to be an autonomous document with its own parameters which can receive its own environment.
A VR Object view is made up of several images taken from different points in a sphere. A view is defined by a camera that moves in a sphere, a target, the center of the sphere and a focal length, as well as 2 horizontal and vertical
angular movement steps.
In this chapter you will learn about the following subjects:
VR Object List

180

VR Object List: for managing VR objects on the list shown.

1. VR object Navigation
VR projection choice:
Hemispherical,
Torus,
Spherical.
Modifying values in angular horizontal and vertical step degrees.
Number of images: Indicates the number of images that will be needed to calculate the VR objects. This
number is dependent on the values defined for the angular horizontal, vertical steps and the horizontal angle.
Focal Length: Changes the focal length when the slider is used or a value is entered in mm or degrees
(adjusts the angular opening of the camera).

NB: An angular step of 10 degrees provides a good compromise between the number of views
needed (size of the file) and fluidity (your objects will not be jerky).
Depth of Field: click
then, in the Preview window, click to define the clear point of the scene, with the
rest remaining blurred. The cursor adjusts the blur amount.
Clipping Box: for defining clipping planes.
Show: in 2D View
Activate: Preview Representation
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2. Lighting:
To handle light schemes linked to the view, select them from the drop-down menus.
Heliodon: links a heliodon to the view. Selecting "None" deactivates the heliodon.
Light Group: Links one or more light groups to the view. Selecting "None" deactivates the light groups.
Neon Shaders: Links one or more Neon Shaders to the view. Selecting "None" deactivates the lighting.

3. Visible layers: check them in the drop-down menu.
4. Environment:
Handles the background and foreground of the scene.
Defining a background type: 3D Sky, Gradient, 2D Image, 3D Image, 3D Cubic
Foreground Images

5. Coordinates:
XYZ Position of Center of VR
Clicking on
locks them and clicking on
unlocks them.
Horizontal Constraint: According to the trigonometric circle, turns the opening point of the VR object. Enter
a value in degrees.
Horizontal Angle: For restricting the opening angle. Enter a value in degrees.
Radius: the radius of the VR.

6. Post-Production:
Applies effects to the current viewpoint: The effects combine into, as well as with the parameters set in the
inspector.

7. Rendering Parameters:
Prepares the document for final rendering.

NB: editing the scene information such as the infinite ground, movement of the origin, redimensioning of the
model and the coordinates may be accessed via the Window menu.

VR Object List
opens the viewpoint list. Each is displayed by name and preview thumbnail.

l

Double click on a name to edit it.
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l

adds a viewpoint,

deletes it.

VR Object Pop-up Menu
l

Right-clicking on a view displays the pop-up menu:

Duplicate: Uses the original to create a new superimposed viewpoint.
Delete: The viewpoint is removed from the list.
Add toPerspectives list
Add to the Parallel Views List
Add to Panoramas List
Add to the Animations list
Depending on option selected, adds current view from Perspectives to Parallel Views, Panoramas, or
Animations.
Edit light: Choose a light. The inspector palette switches to Lights mode, and the light is selected.
Edit Heliodon: The palette inspector switches to Heliodon mode and the heliodon is selected.
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The Animation Inspector
Animations: General Information
A sequence is defined by a camera: A viewpoint, an aim point and a focus distance.
Each sequence is considered as an individual document with its own parameters:
In this chapter you will learn about the following subjects:
General Animation Information
Sequence
Real Time Display:
Elements that can be animated
Animation List
Animation coordinates
Animatable Camera Parameters
What can be animated
What cannot be animated
Animatable Heliodon Parameters
What can be animated
What cannot be animated
Animatable Light Parameters
What can be animated
What cannot be animated
Animatable Object Parameters
What can be animated
What cannot be animated

184
184
185
185
185
186
187
187
187
188
188
188
189
189
189
189
189
190

Animation List: for managing animations on the list shown.
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1. Animations
Depth of Field: click
then, in the Preview window, click to define the clear point of the scene, with the
rest remaining blurred. The cursor adjusts the blur amount.
Clipping Box: for defining clipping planes.
n Show: in 2D View
n Activate: Preview Representation

2. Lighting
To handle light schemes linked to the view, select them from the drop-down menus.
Heliodon: links a heliodon to the view. Selecting "None" deactivates the heliodon.
Light Group: links one or more light groups to the view. Selecting "None" deactivates the light groups.
Neon Shaders: Links one or more Neon Shaders to the view. Selecting "None" deactivates the lighting.

3. Visible layers: check them in the drop-down menu.
4. Environment:
Handles the background and foreground of the scene.
Define a background: Background type: 3D Sky, Gradient, 2D Image, 3D Image, 3D Cubic.
Background type: Foreground Images

5. Coordinates:
6. Post-Production: Applies effects to the current viewpoint: The effects combine into, as well as
with the parameters set in the inspector.
7. Rendering Parameters: Prepares the document for final rendering.

NB: editing the scene information such as the infinite ground, movement of the origin, redimensioning of
the model and the coordinates may be accessed via the Window menu.
See " Working with Camera Animation in 2D View" page 54
See " Working with Light Animation in 2D View" page 61
See "Working with Object Animations in 2D View" page 68
See " The Timeline Window" page 78
See "General Preview Display Shortcuts" page 203

General Animation Information
Animation makes it possible to produce and play a scene made up of one or more sequences.

Sequence
A sequence retraces the camera path in time.

NB: The camera may also be a fixed plane in which object lights, or a heliodon are animated.
The camera path is processed in:
l

l
l
l

The Animation Inspector, (animating parameters, focal distance, association to lighting groups, depth of field,
roll, etc).
The Timeline window, (time management).
The Preview Window (managing camera targets).
The 2D View. (Managing paths: cameras, lights, objects).

Animating in a sequence of parameters for other inspectors:
Parameters respectively accessible from:
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l
l
l
l
l

Light Inspector*: Illumination configurations
Heliodon Inspector*: Heliodon configuration
Object Inspector*: Object configurations
2D View: Creating and editing paths for moving cameras, lights and objects.
Timeline Window: Creating and editing keyframes (changing parameter of an element at a T instant, interpolation of parameter changes between two keyframes), synchronizing keyframes of elements that either belong
or do not belong to the same inspector.

*
NB: To animate the parameters for light, heliodon and object inspectors, they must first be displayed in
the Animation Inspector before being displayed in the relevant inspector, i.e. light, heliodon, object.

Real Time Display:
l

Preview Window: Shows and plays in real time the result of adjustments.

Elements that can be animated
All elements can be animated except for those related to the Shader inspector, or which are listed as not being able to
be animated in:
l
l
l
l

Animatable Camera Parameters See "Animatable Camera Parameters" page 187
Animatable Heliodon Parameters See "Animatable Heliodon Parameters" page 188
Animatable Light Parameters See "Animatable Light Parameters" page 189
Animatable Object Parameters See "Animatable Object Parameters" page 189

Animation List
opens the sequence list. Each is displayed by name and preview thumbnail.

l
l

To edit, double-click on the name.
adds a sequence,

deletes it.
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Animation Pop-up Menu
l

Right-clicking on a view displays the pop-up menu:

Duplicate: Starting with the current sequence, a sequence is created that takes up the position of the camera
but not the existing path.
Delete: The current sequence is removed from the list.
Add to Perspectives list
Add toParallel Views List:
Add to Panoramas List
Add toVRObject List
Depending on option selected, adds current view from Perspectives to Parallel Views, Panoramas, or VR
Objects.
Edit Heliodon: The palette inspector switches to Heliodon mode and the heliodon is selected.
Edit light: select a light, the inspector palette switches to Lights mode and the light is selected.

Animation coordinates
From the viewpoint (Position) and Target of the camera.

The Camera Position defines:
l
l

Viewpoint position: Provides the x, y, z coordinates.Entering new values redefines the position.
Target Position. 2 options:
On a fixed vertex: The camera moves on its path aiming at a fixed vertex in the scene. The fixed vertex is
defined in the Preview window or in 2D View.

Orientation following the path : The camera moves tangentially to the path. Horizontal and vertical angles can
be defined relative to this tangent. The Distance provides the distance between the camera and the aim point.
Target on: choose between target on a fixed vertex or on an object defined as target.
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NB: Using the Timeline, in a single sequence, the camera can change behavior several times.

Animatable Camera Parameters
What can be animated
From the Camera Inspectors

Editing in

Camera coordinates

Animation Inspectors - Coordinate tab - 2D
View

Target coordinates

Animation Inspectors - Coordinate tab - 2D
View

H target angle relative to the tangent to the
path

Animation inspector - Coordinate tab

V target angle relative to the tangent to the
path

Animation inspector - Coordinate tab

Activated and/or displayed clipping box

Animation Inspectors - Coordinate tab - 2D
View

Modification box
Focus

Animation Inspectors - Coordinate tab - 2D
View

Colored background

Animations inspector

Depth of Field

Animations inspector

Atmosphere

Animations inspector

Roll

Animations inspector

Settings are available in the Animation Inspector. See "The Animation Inspector " page 183

What cannot be animated
Cameras
Ambient
Changing a heliodon
Changing light groups
Background and foreground images
Changing the Photorealistic/Hatch rendering engine
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Animatable Heliodon Parameters
What can be animated
From the Heliodon inspector

Editing in

Time

Heliodon inspector

Date

Heliodon inspector

Power of the Sun

Heliodon inspector

Celestial illumination

Heliodon inspector

Celestial color

Heliodon inspector

Color

Heliodon inspector

Lens flare

Heliodon inspector

Halo type

Heliodon inspector

Lens flare power

Heliodon inspector

Parameters are available in the Heliodon Inspector. See "The Heliodons Inspector" page 143

What cannot be animated
Heliodons
Cities
Shadows ON/OFF
Shadow type
Contribution to radiosity
Colored sun On/Off
Orientation of North
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Animatable Light Parameters
What can be animated
From the Light inspector

Editing in

Status ON/OFF

Light inspector

Illumination type (omni, spot,
direct.)

Light inspector

Power

Light inspector

Associating a halo

Light inspector

Changing halo

Light inspector

Shadows ON/OFF

Light inspector

Soft shadows

Light inspector

Shadow power

Light inspector

Source coordinates

Light Inspectors - Coordinate tab - 2D
View

Target coordinates

Light Inspectors - Coordinate tab - 2D
View

Spot Opening Angle

Light Inspectors - Coordinate tab - 2D
View

Falloff

Light Inspectors - Coordinate tab - 2D
View

Soft shadows bias

Light Inspectors - Coordinate tab - 2D
View

Distance A

Light Inspectors - Coordinate tab - 2D
View

Parameters are available in the Light Inspector. See "L’inspecteur des Lumières" page 149

What cannot be animated
Lights
Radiosity contribution

Animatable Object Parameters
What can be animated
From the Object inspectors

Editing in

Coordinates

Object inspector on the Coordinate
tab

Rotation

Object inspector

Dimensions

Object inspector
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l
l

For 3D vegetation: Plant sizes, colors, date, etc.
For Billboards: Size, luminosity, brightness, etc.

Parameters are available in the Object Inspector. See "The Objects Inspector" page 123

What cannot be animated
Objects
Scene coordinates
Scene rotation
Scene dimensions
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Preferences
Artlantis settings enable you to organize the work environment.
In this chapter you will learn about the following subjects:
Preference Settings

191

Preference Settings
Artlantis settings enable you to organize the work environment.

Access: Artlantis Menu > Preferences

General

l
l

Work units: In the drop-down menu choose (mm, m, cm, inches, feet and inches).
Focal units: select mm or degrees for the viewpoint inspector focus.
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l

l

l

l

Default location: In the pop-up menu. The change becomes effective the next time a DWG, DWF, DXF, OBJ
and 3DS file that does not contain any location-related information is opened.
Viewpoint update mode: select the viewpoint update in manual or automatic mode. This concerns the positions
of the camera, the viewpoint, the roll and focal length.
Automatic
Each time the camera settings are modified, it is the last state that is used and the previous states are not
retained. Except when clicking on the Back tool, provided the document has not been saved in the meanwhile or another viewpoint has not been activated).
Manual
When the camera settings have been modified and the user wishes to keep them, the user must update the
new state.
If the new state is not updated, the next time the file is saved or the next time the viewpoint is changed, the
viewpoint that was last updated will be the one to display.

Update the viewpoint by clicking on

in the Preview window toolbar.

NB: Updating or not updating the viewpoint will have no effect on edits to Shaders, objects, lights,
or backgrounds, which continue to be backed up automatically.

l

In manual update mode, in the viewpoint list, the thumbnails will be updated when the use clicks the
"Update" button, or when a new view is activated.
The thumbnails in the list will not be updated when Shaders, lights or backgrounds are modified.
Display expert rendering settings: checked, in the viewpoint rendering settings window, enables refinements to
be made using the setting supplements settings.

Preview

l

l

Max Preview size:
Choice of the maximum size of the Preview window content (using the shortcut Command +). In the pop-up
menu (640, 800, 1024, 1200), the value means the size of the preview image displayed in that window.
Automatic permutation in OpenGL mode:
When this box is checked, the display mode switches from photorealistic to OpenGL mode when the camera
is moved. Speeds up display in small configurations.

NB: The refresh time of the window is proportional to the size of the display.
l

OpenGL options
The following options affect the Preview window rendering display in OpenGL mode.
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l

Camera light:
if checked, simulates the white omni-directional light emitted from the camera. The scene is always lit.

NB: This option is independent of the anti-aliasing of the final rendering.
l

All light sources:
When checked, OpenGL takes into account all active light sources: lights and sun.

NB: The refresh time of Preview slows down when the option is activated.
l

Last manipulated Light Shadow:
When checked, OpenGL takes into account shadows cast from the last light or sun manipulated.

NB: The refresh time of Preview slows down when the option is activated.
l

FPS:
Increases or reduces OpenGL navigation fluidity. The greater the number, the better the fluidity. On the other
hand, a low figure gives better image definition.
Move the slider or enter a value of between 1 and 30 images per second.

Final Render
l

Rendering output folder:
2 choices for the default rendering output folder:
n Document directory: The renderings are saved at the same level as the current file.
n Default recordings: The renderings are saved in the folder defined by clicking on Select Folder...

Default file format: in the drop-down menu, choose: JPEG, BMP, TARGA, PICT, TIFF, Photoshop,
Piranesi.
Default file name: either the name of the viewpoint, or the name of the document plus the name of the
viewpoint.
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Mouse and Keyboard Shortcuts
Available in 2D View and Preview.
In this chapter you will learn about the following subjects:
General 2D Shortcuts
2D Shortcuts - Working with Perspectives
2D Shortcuts - Working with Parallel Views
2D Shortcuts - Working with the Clipping Box
2D Shortcuts - Working with Objects
2D View shortcuts - Working with Lights
2D Shortcuts - Working with Heliodons
2D Shortcuts - Working with Panoramas
2D Shortcuts - Working with VR Objects
2D Shortcuts - Manipulating Animations
General Preview Display Shortcuts
General Preview Navigation Shortcuts
Activated Object Inspector Preview Shortcuts
Preview Shortcuts Specific to Insertion into Site (Perspectives inspector)
Activated Heliodon Inspector Preview Shortcuts
Activated Shaders Inspector Preview Shortcuts

196
197
197
197
199
200
200
202
202
203
203
204
205
206
206
208
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General 2D Shortcuts
Actions

Combination and Key Strokes

Enlarge display
Reduce the display
Fit in Window

Camera pan movement.
&
Enlarge a part of the window by drawing a rectangle with 2 opposing angles

ou

&

+ or - Dynamic Zoom as a function of the point being aimed at

Following the view, depress the keyboard
key:
Change 2D View
1 (Above), 2 (Front), 3 (Right), 4 (Left), 5
(Rear)
Previous view
&
Next View
&

Activate the Pop-up menu

Force a movement on a 45° incremental scale.
&
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2D Shortcuts - Working with Perspectives
Combination and Key Strokes

Actions

Inspectors: Shaders, Lights, Heliodons, Objects and Perspectives
Graphically move:
The camera, the target or the bisector

Graphically modify the focal distance

Duplicate a Viewpoint:
&

2D Shortcuts - Working with Parallel Views
Combination and Key Strokes

Actions

Inspectors: Shaders, Lights, Heliodons, Objects, and Parallel
Views.
Graphically move:
The camera, the target or the
bisector

Graphically modify the section
width

Duplicate a Viewpoint:
&

2D Shortcuts - Working with the Clipping Box
In order to use the Clipping Box tool, the "Show" option must be checked in the Perspectives inspector.

The command takes effect with all inspectors
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Actions:

Clipping box displayed

l

Blue contour line entry

l

When the contour light moves, the cutting plane operates in Preview.

l

To provide an angle to the clipping box, grab the handle on the circular cursor and turn it.
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l

Move the origin of the circular cursor by clicking and dragging from the center.

The recall lines coming from the center help in positioning.

2D Shortcuts - Working with Objects
Actions
You can only manipulate objects in Objects
mode.

Move an object

Duplicate an Object
&

&

&

Duplicate an object several times
increase or

decrease the number of copies

Redefine the anchor point of an
object
&
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2D View shortcuts - Working with Lights
Actions

Combination and Key Strokes
Inspectors: Shaders, Lights, Perspectives, Parallel
Views, Panoramas, VR Objects, Animations.

Graphically move the source, the target and the bisector,
modify the light cone and the lighting distances.

Duplicate a light

&

&
Duplicate a light several times
to increase or

decrease the number of copies.

2D Shortcuts - Working with Heliodons
Depending on the operation chosen in the Heliodons inspector Location, Manual, 45°.

Location option:

l

Defines the direction North by moving the yellow point around the compass.
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Result: Shadows are recalculated.

Manual Sun Position option

l

Graphically moves the sun icon around the yellow circle.

Result: Shadows are recalculated.

There is an option for shadows to be projected at 45° depending on the position of the viewpoint.

l

The angle between the viewpoint bisecting line and the position of the sun always remains at 45°.

Result: Even after the camera is graphically moved, the shadows always stay at 45° to the camera.
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2D Shortcuts - Working with Panoramas
Actions

Combination and Key Strokes
Inspectors: Shaders, Lights, Heliodons, Objects and
Panoramas

Graphically move:
The camera, the target or the bisector

Graphically modify the focus (Perspectives, VR Objects,
Animations)
Graphically modify the view width (Panoramas)

Duplicate a Viewpoint:
&

2D Shortcuts - Working with VR Objects
Actions

Combination and Key Strokes
Inspectors: Shaders, Lights, Heliodons, Objects and
VR Objects

Graphically move:
The camera, the target or the bisector

Graphically modify the focus (Perspectives, VR Objects,
Animations)
Graphically modify the view width (Panoramas)

Duplicate a Viewpoint:
&
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2D Shortcuts - Manipulating Animations
Combination and Key Strokes

Actions

Inspectors: Shaders, Lights, Heliodons, Objects
and Animations
Path edit mode:
For graphically moving the camera, viewpoint, bisecting line,
path, or a control point.
Time edit mode:
For moving a keyframe

Graphically modify the focal distance

Extend Path:
&
To the path's final control point

General Preview Display Shortcuts
Actions

Combination and Key Strokes

Enlarge the content of the Preview window.
&

NB: the camera does not move.
Reduce the content of the Preview window.

&

NB: the camera does not move.
Fit in Window

&
Zoom +
&

release, trace a rectangle

Zoom &

release, then

trace a rectangle
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General Preview Navigation Shortcuts
Actions

Combination and Key Strokes
Animations
Mode
Parallel
Views and
Perspectives
Mode.

Turn the camera around the clicked point

Panoramas
Mode.

VR
Objects
Mode.

N/A

N/A

NB: For
a camera
with no
path.

&

Turn the camera around its target

&

N/A

Turn the camera on itself.

N/A

The + or - Dynamic Zoom is focused on the position
of the cursor.

Change the focus distance.

N/A

N/A

N/A

N/A

Camera pan movement.

N/A

N/A

N/A

N/A

NB: For
a camera
with no
path.

Pan To:
&
Place a viewpoint perpendicular to a surface.
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&
Click
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&

Move the camera through the scene.

Click

When the cursor is pointed towards the top of the
window, the camera advances in the scene; when it
is pointed towards the bottom, it moves laterally
away towards one of the sides

&
Click

N/A

NB: For
a camera
with no
path.

N/A

NB: In Shaders, Lights, Heliodons and Objects modes, you can navigate just like in the viewpoints inspector
by releasing the current Edit Shaders mode. Press the
binations described in the table.

key and then use the com-

Example:
In Shaders mode with a Perspectives display, you must use the following shortcut to turn the camera around its tar-

get:
Edit Shaders mode reactivates.

&

&

. Once you release

,

Activated Object Inspector Preview Shortcuts
Actions

Combination and Key
Strokes

Select and/or move the object.

Duplicate Object.

Replace the object with a different one from a drag & drop from Catalog or Desktop.

Move with no change of the hierarchy

&

&

&
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Preview Shortcuts Specific to Insertion into Site (Perspectives inspector)
Actions

Combination and Key
Strokes

Move the origin of the trihedron, pivot the axes or slide the yellow cursor to the defined
reference axis.

Move the origin of the axes while maintaining the directions.

&

Show/Hide the magnifying glass. Each incrementation increases the content of the magnifying glass from 2x to 8x.

Activated Heliodon Inspector Preview Shortcuts

Actions
Manually move the sun.

NB :Only available when the Manual option is selected in the Heliodon inspector.

Define fog start (advanced heliodon settings).

Click on the target icon and then click on an element in Preview.

Example of manually moving the sun:

Preview: Manually moving the sun.
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Combination
and Key
Strokes

Mouse and Keyboard Shortcuts -

Result after movement.

NB: If there is no sun in the current view, you can make it display by modifying its position in 2D View.

Example of positioning the start of fog:

Click on the airplane in the foreground to define the fog start.

Click on the airplane in the second plane to redefine the fog start.
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Activated Shaders Inspector Preview Shortcuts
Actions

Combination and Key Strokes

Select a Material or a Shader

NB: The material is highlighted.

Select a material or a Shader located behind a transparent surface.

&

Select a material or a Shader by reflection in another material.

NB: if the Specular slider is at maximum.

Duplicate a Shader or texture.
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&

&

